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1 Evaluation and Evaluation Classic

The Evaluation Classic module
The Evaluation module within UNICORN 7.0 contains the basic functionality needed
when evaluating chromatography results. How to use the Evaluation functions is de-
scribed in the integrated Getting Started view and via tool tips.

This manual describes the Evaluation Classic module which include additional features
and requires a separate license.

All the examples given are from the Evaluation Classic module, but the formulas and
algorithms described are also useful when working with the Evaluation module

When to use Evaluation Classic
Most users only need Evaluation, but some features are only available in Evaluation
Classic. These features are listed in the following table:

DescriptionFunctionSymbol

DoE is used to find out, in a systematic way, which
run parameters affect a process to be run and
how to find optimal values for these parameters
to obtain the best possible result using a minimum
number of runs.

Design of Ex-
periments

The Column Logbook enables the run history for
an individual column to be traced, for example,
how many CIP runs have been performed using
that column.

Column Log-
book

Multi result peak compare is used to make statis-
tical comparisons between peaks in different re-
sults, for example by comparing area, retention,
etc.

Multi Result
Peak Compare

Frequently used evaluation procedures can be
recorded and saved. The saved sequence of pro-
cedure instructions can be included as part of a
method. When the method is run, the evaluation
procedures will be performed automatically.

Procedures
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DescriptionFunctionSymbol

In addition to peak integration a number of oper-
ations can be performed. E.g. apply mathematical
operations to create resulting target curves, shift
retention/amplitude to better visualize differences
in between runs, smooth curves to reduce noise
or create histograms.

Note:

The shift offset operation is available in the Evalu-
ation module.

The curve op-
erations on
the Opera-
tions menu.

Generate a customized report of the evaluated
result.

Customize re-
port
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2 Introducing UNICORN Evaluation
Classic

About this chapter
This chapter contains:

• A general introduction to the evaluation of results using the Evaluation Classic
module.

• Information about the user documentation for UNICORN 7.0, including an overview
of related documents describing the use of the software.

Software declaration of
conformity

UNICORN 7.0 is technically compatible with all relevant sections of FDA 21 CFR Part 11.

A part 11-system assessment checklist is available on request from your local GE
Healthcare representative.

In this chapter
This chapter contains these sections:

See pageSection

82.1 About evaluation of UNICORN results

102.2 About this manual

122.3 Associated documentation
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2.1 About evaluation of UNICORN results

Introduction
This section is a brief introduction to the evaluation of results created in UNICORN and
a description of the scope of this manual.

What is UNICORN?
UNICORN is a complete software package for:

• control and supervision of chromatography systems.

• evaluation and analysis of the results from separation runs.

Workflow
The workflow in UNICORN can be divided into four distinct stages. The flow chart below
shows the workflow stages.

2. Run the method

1. Create a method

3. Evaluate the results

4. Compile a report

This manual describes steps 3 and 4 of this workflow.

Step 1, how to create and optimize methods, is described in the UNICORN
Method Manual. Step 2, how to perform method runs, is described in the
UNICORN System Control Manual and in the instrument manual.

Tip:
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Evaluate the results
A result is automatically generated at the end of a run and contains a complete record,
including controlling method, system settings, monitored data and run log. The complete
result is recorded in the UNICORN database.

Using the UNICORN Evaluation Classic module you can view and analyze result data
and optimize the presentation of the results, for example by:

• integrating peaks

• measuring peak data

• comparing curves and chromatograms from different results

etc.

The source result data created during the run are always saved regardless of
your editing operations. Edited curves are saved as copies, with the original
source curve uncompromized. The original result curves cannot be deleted or
overwritten.

Note:

Compile a report
When you are satisfied with the result, you may compile a report using the UNICORN
Evaluation Classic module. The.report can be anything from a simple print of a chro-
matogram, showing selected curves, to a comprehensive report containing, for example:

• chromatograms from several results

• run data in text form

• log entries

• images

The report options are described in Section 4.6 Generate reports, on page 75.
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2.2 About this manual

Introduction
This section describes the purpose of the manual, the general structure and conventions
applied in the text, and some prerequisites that should be fulfilled before you start to
apply any of the procedures described in the following chapters.

The purpose of the UNICORN
Evaluation Manual

The purpose of the UNICORN Evaluation Manual is to provide a comprehensive guide to
the evaluation features of the UNICORN software. The Evaluation Classic module of the
software is presented, along with practical instructions on how to use the functions.

Basically the manual covers the following, major topics:

• how to view results and how to compile result reports

• how to edit and optimize the representation of the results

and

• how to automate frequent evaluation procedures.

The manual also describes algorithms and theoretical models used in the evaluations.

The UNICORN Evaluation Manual does not describe the functions of every
command in all panels and dialogs of the user interface. Refer to the online
user interface help for information about commands that are not described
in this manual. The online help in the Evaluation Classic module is accessed
either by clicking the Help button in a software dialog or by pressing the F1
key.

Note:

Document structure
Each chapter starts with a brief overview that presents the contents and the headings
for the sections that the chapter contains. Most sections begin with an introduction that
summarizes the content. Some sections are divided into sub-sections, each with an
overview of the contents.

A section is divided into blocks of information with separating lines. The blocks are
identified by a label extending into the margin (such as the label Document structure
above). This makes it easier for you to quickly scan a page to find the exact topic you
are looking for.
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Typographical conventions
Menu commands, field names and other text items from the software are quoted exactly
as they appear on the screen, in a bold italic typeface:

Example: Result Navigator

Menu paths are shown in a bold italic typeface with a separating colon between each
level:

Example: Edit:Delete:Curves i.e., the menu option Curves in the sub-menu Delete from
the Edit menu.

Controls on the instrument, computer or keyboard keys are shown with a bold, regular
typeface:

Example: Press the Delete key.

Text that the user must either type exactly as shown in the manual, or that UNICORN
displays as a response (not a regular part of the graphic user interface), is represented
by a monospaced typeface within quotation marks:

Example: "Connection change"

File system paths are represented by a monospaced typeface:

Example: C:\Program Files\GE Healthcare\UNICORN\

Prerequisites
The following prerequisites must be fulfilled before you can use this manual the way it
is intended:

• You need to have a general understanding of how your PC and Windows® work. In
most cases universal computer functions will not be explained.

• UNICORN must be installed and configured correctly on your computer.

• Your user profile and access rights must be set up, and you must be able to log on
to UNICORN, access a database and results files.

• You need to understand the general concepts of liquid chromatography. Terminology
and functionalities will be explained only when they differ from normal practice.

UNICORN 7.0 Evaluation Manual 29-1108-88 AA 11

2 Introducing UNICORN Evaluation Classic
2.2 About this manual



2.3 Associated documentation

Introduction
This section describes the user documentation that is delivered with UNICORN.

User documentation
The user documentation listed in the table below is available from the Help menu in
UNICORN and as printed books.

Main contentsDocument

Overview and detailed descriptions of the method cre-
ation features in UNICORN. Instructions on how to use
the software. Workflow descriptions for common opera-
tions.

UNICORN Method Manual

Overview and detailed descriptions of the Evaluation
Classic module. Workflow descriptions for common op-
erations. Description of the evaluation algorithms used
in UNICORN.

UNICORN Evaluation
Manual

Overview and detailed description of network setup and
complete software installation. Administration of
UNICORN and the UNICORN database.

UNICORN Administration
and Technical Manual

Overview and detailed description of the system control
features in UNICORN. Includes general operation, system
settings and instructions on how to perform a run.

UNICORN System Control
Manual

Dialog descriptions for UNICORN (from the Help menu).UNICORN Online Help
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3 The UNICORN Evaluation Classic
module

Introduction
This chapter is an overview of the UNICORN Evaluation Classic module with descriptions
of some of the elements of the user interface.

A user may be assigned to an Access Group which is set up so that the user
only has limited access to the various UNICORN modules. The modules that
are unavailable cannot be selected or opened when the program is started.

Note:

In this chapter
This chapter contains this section:

See pageSection

143.1 Evaluation Classic module
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3.1 Evaluation Classic module

The Evaluation Classic module
interface

The interface consists of a pane where the current result is displayed and the Result
Navigator. Both panes are described below.
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Evaluation Classic module
window

The illustration below shows the different parts of the Evaluation Classic module with a
result displayed:

1 Result Navigator

2 Chromatogram pane

3 Peak table
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Toolbarbuttons in theEvaluation
Classic module

The following table describes the toolbar buttons in the Evaluation Classic module.

FunctionButton

Opens the Result Navigator.

The Result Navigator is described below.

Note:

This function is also available in the Viewmenu.

Opens a new, empty result.

Note:

This function is also available in the Filemenu.

Opens the Open Curves To Compare dialog.

You may use the dialog to search for curves to compare in specified folders,
results or chromatograms. This dialog is described in Section 5.5 Compare
different runs, on page 161.

Note:

This function is also available in the Filemenu.

Saves the current result.

If the current result is new and has not been saved yet, the Save As dialog
will open so that the result can be named and saved in a selected folder.

Note:

This function is also available in the Filemenu.

Opens the Print Chromatograms dialog.

This dialog is used for printing the chromatograms on a selected printer.
There are options for the print layout and Preview before printing. This di-
alog is described in Section 4.4 Print chromatograms and peak data, on
page 60.

Note:

This function is also available in the Filemenu.

Cuts the selected result or folder from the current place in the file structure.

Note:

This function is available only for items in the Result Navigator pane. Cut
is also available in the Editmenu.

16 UNICORN 7.0 Evaluation Manual 29-1108-88 AA

3 The UNICORN Evaluation Classic module
3.1 Evaluation Classic module



FunctionButton

• Copies the selected result or folder, when the Result Navigator is se-
lected.

or

• Opens the Copy to Clipboard dialog, when an open result is selected.
Either the curve window or the peak table data may be copied to the
Windows clipboard.

Note:

This function is also available in the Editmenu.

Pastes a copied result or folder to the selected folder.

Note:

This function is available only for items in the Result Navigator pane. Paste
is also available in the Editmenu.

Returns the result to the state it was in before the last change (Undo).

Note:

This function is also available in the Editmenu.

Opens the Generate Report dialog.

TheGenerate Reportdialog is used to preview and print reports in selected,
saved formats and also to delete saved formats.

When New is selected, or a saved format is selected for editing in the
Generate Report dialog, the Customize Report window is opened in the
Evaluation Classic module. The editing process is described in detail in
Section 4.6 Generate reports, on page 75.

Note:

This function is also available in the Filemenu.

Opens the Documentation dialog.

The dialog contains the complete documentation for the result, including
for example theRun Log, Evaluation Log and SystemSettings. This dialog
is described in Section 4.5 Run documentation, on page 63.

Note:

This function is also available in the Viewmenu.
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FunctionButton

Opens the Customize dialog where curve and axis settings, styles and
colors, header content and text items can be set. Saved layouts can be
selected and edited layouts can be saved for later use.

This dialog and the layout operations are described in Section 4.3 Optimize
the presentation of chromatograms, on page 40.

Note:

This dialog can also be opened by clickingCustomize on the chromatogram
right-click shortcut menu.

Opens the Peak Integrate dialog, where curve characteristics including
peak areas, retention time and peak widths are identified and measured.

This dialog is described in detail in Section 5.2 Peak integration, on page102.

Note:

This function is also available in the Integratemenu.

Opens the Multi Result Peak Compare wizard.

This wizard can be used to compare peak data from different results, for
example from a complete series of Scouting runs. The options and how
to use the wizard is described in Section 5.6 Multi Result Peak Compare
wizard, on page 181.

Note:

This function is also available in the Filemenu.

Opens theColumnHandling dialog, where information about the columns
is viewed and edited.

Note:

This function is also available in the Toolsmenu.

Switches to the UNICORN Evaluation module.
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The Result Navigator pane
The Result Navigator shows all the user folders, individual results and Design of Exper-
iment results that are available.

Using the tool icons, Edit menu commands or the right-click menu, results may for ex-
ample be copied, deleted, or renamed.

TheResult Navigatorpane features are described in Section 4.2 Locate results,
on page 30.

Note:
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Result Navigator Auto Hide
The Result Navigator may either be displayed open in the left portion of the Evaluation
Classic module, or the Auto Hide function can be selected by clicking the pin symbol in
the top right-hand corner of the pane.

FunctionPin di-
rection

Auto Hide is off. Click the pin symbol to turn the function on.

Auto Hide is on. Click the pin symbol to turn the function off.

If Auto Hide is selected, the Result Navigator opens automatically when the mouse
pointer is placed over its tab. It remains open as long as the mouse pointer remains over
the pane. The pane closes automatically when the pointer is moved outside.
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The Chromatogram pane
The illustration below shows the Chromatogram pane.

The current result contains two chromatograms. The chromatograms are displayed by
clicking the corresponding tab. A Peak Table is also displayed under this chromatogram.
Peak Tables are described in detail in Section 5.2.3 Display peak data, on page 108.

Docking chromatogram panes
If a result contains several chromatograms, each chromatogram will be displayed in its
own pane. The chromatograms can be stacked on top of each other and selected by
clicking the corresponding tab. They can also be arranged in various positions using a
docking function. The arrangement of chromatograms is described in Section 5.5.1 Open
and compare chromatograms, on page 162.
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Design of Experiments results
The illustration below shows the Design of Experiments pane in the Evaluation Classic
module.

Evaluation of Design of Experiments results including analysis, prediction and optimiza-
tion of experiments is described in UNICORN Method Manual.
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4 View and present the results

About this chapter
This chapter describes how to present the chromatograms and curves of your result file
and how to create and print reports.

In this chapter
This chapter contains these sections:

See pageSection

244.1 Open and view results

304.2 Locate results

404.3 Optimize the presentation of chromatograms

604.4 Print chromatograms and peak data

634.5 Run documentation

754.6 Generate reports
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4.1 Open and view results

Introduction
All contents of the result files are opened in the Evaluation Classic module where you
can analyze the results and compile reports. The Evaluation Classic module user interface
and toolbar icons are described in Section 3.1 Evaluation Classic module, on page 14.

The result files that are located in folders accessible to you are shown in the Result
Navigator. There are different ways to locate the specific result that you are looking for.
Section 4.2 Locate results, on page30 describes this. However, in this section an additional
aid to identify a certain result and locate specific curves is also described. This preview
function is called Quick View. This section also describes how to highlight curves in a
chromatogram, read curve values using a marker and save curve data as a Snapshot.

How to open specific chromatograms and curves is described in Section 5.5.1 Open and
compare chromatograms, on page 162 and Section 5.5.2 Open and compare curves, on
page 169.

Open a result in the Evaluation
Classic module

There are four ways to open a result from the Result Navigator:

• Select a result and press the Enter key

or

• Double-click a result

or

• Right-click a result and click Open on the shortcut menu

or

• Select a result and click the Open toolbar button in the Result Navigator.

Result: The result is opened in the chromatogram pane.
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Only one result at a time may be opened this way. If you open a new result, the previous
result will automatically close. However, you may open several chromatograms from
different results. This is described in Section 5.5.1 Open and compare chromatograms,
on page 162.

When working in a network environment, it is not possible to edit the same
result file from two different locations simultaneously. If the result is already
open at another networkworkstation, you can only open it in read-onlymode.
A message similar to the illustration below will open.

Note:

Illustration – a result open in the
Evaluation Classic module
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A result may contain several chromatograms and corresponding peak tables, which will
open as one or several tabs. Each chromatogram can be selected by clicking the corre-
sponding tab. The selected tab has a light color and its information is displayed in the
active window.

The chromatograms may also be shown simultaneously if you click Tile All Chro-
matograms on the View menu.

Highlight or select a curve
You can highlight or select an individual curve in the chromatogram. The table below
describes the differences:

Then...If you...

a pop-up box will display the curve name.hold your mouse pointer
over a curve segment

the curve and the short line segment in front of the curve
name become bold.

hold your mouse pointer
over a curve name

the Y-axis shows the values for this specific curve.click a curve segment or
a curve name
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Insert a vertical marker
The vertical marker is used to measure the values for a specific curve position. Right-
click in the chromatogram and click Vertical marker. Move the marker along the X-axis
and read the X-axis and Y-axis values of the selected curve in the box in the top left
corner of the chromatogram.

The marker will measure the curve that currently is selected if several curves
are displayed in the chromatogram. The marker will have the same color as
the selected curve.

Note:

Set marker reference
You can use the vertical marker for more measurements than just the readings from a
specific curve position. The following table describes how to use the marker to determine
Delta Peak and Mean Y-axis values.

ActionStep

• Position the marker where you want to begin the measurement.

• Right-click and then click Set vertical marker reference point.

Result: The reference point is set to the position shown in the box in the top
left corner of the chromatogram.

1
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ActionStep

• Drag the marker to the point where you want the measurement to end.

Result: The measured area is colored as illustrated below:

2

• Read the Delta and Mean values from the box:3
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Snapshots
You can take a Snapshot of all the curve values at the marker position. The following
table below describes this:

ActionStep

• Insert a vertical marker where you want to take the Snapshot.

• Right-click, and then click Snapshot.

Result: The Snapshot dialog opens.

1

• Click Save to save the Snapshot

Result: The Save As dialog opens and you can save the Snapshot as a
text file.

or

• Click Print to print the Snapshot

Result: The Print dialog opens and you can print the Snapshot using the
selected printer.

Note:

Snapshots taken during the method run are saved directly to the result and
can be accessed by clicking the Snapshot sub-tab in the Result Information
tab of the Documentation dialog.

2

Click Close to close the Snapshot dialog.3

The snaphot will record only the values of curves that are displayed. Curves
that are filtered will not be recorded.

Note:
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4.2 Locate results

Introduction
With exception for the Administration module, there are navigator panes available in
all UNICORN modules. The navigator panes can be used to locate and open methods
and result files and to arrange files in folders.

The Result Navigator in the Evaluation Classic module consists of the same type of
navigator pane as the other UNICORN modules, but also contains a pane for Recent
Runs and a specific search pane, Find Results. If desired, the Result Navigator can also
display methods.

Show the navigator pane
To open and display the navigator panes, either

• click the Result Navigator on the View menu

or

• click the Open Result Navigator toolbar button.

As described in the general overview of the Evaluation Classic module in Sec-
tion 3.1 Evaluation Classic module, on page 14, Auto Hide can be selected for
the navigator panes.

Note:

Navigator toolbar
The following table shows the navigator toolbar buttons:

FunctionButton

Opens the selected result.

Note:

Selected items can also be opened by clicking Open on the Filemenu or by
double-clicking the file in the navigator pane. The Open command on the
right-click shortcutmenu can also be used to open selected chromatograms,
curves or peak tables.
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FunctionButton

Creates a new folder in the folder that is currently selected.

Note:

This function is also available by clicking New Folder on the Filemenu or
clicking New Folder on the right-click shortcut menu.

Performs aRefresh in the navigator pane to update all items to the current
status.

Note:

This function is also available on the Viewmenu. However, note that the
Refreshmenu command will update both the items in the navigator pane
and items open in themodule. The navigator toolbar buttonwill only update
the navigator pane.

Opens the View Details list where the following optional information
columns may be selected for display in the navigator pane:

• System

• Created by

• Last modified date

Filter settings
The Result Navigator will normally show only results and Design of Experiments results
(Design of Experiments are only available for some systems). This is the default filter
setting for the items that are displayed. However, the navigator may also show items
that primarily are used in another UNICORN module, i.e., methods and method queues.
The options are:

• Results, DoE Results – showing only items that are relevant in the Evaluation Classic
module

• All – showing all items including method items and archived items
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• All except Archived – only archived items are filtered

The navigator paneswill only show folders that you have access to. Your access
rights to folders are defined in the Access Groups and Network Users in the
Administrationmodule. The user setup process is described in the UNICORN
Administration and Technical Manual.

Note:

Expand and collapse folders
When you select a folder in the navigators, the folders and results immediately below
the selected folder are displayed.

If you have expanded the folder structure to lower levels, you may want to collapse all
folders below a selected top folder, to simplify browsing.

• Right-click a folder and click Expand/Collapse All.

Result: The folder structure is collapsed to the selected folder level.

File properties
You can display some of the properties of a selected result in the navigator pane.

• Right-click a result and click Properties.

Result: The Properties dialog opens.
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The Recent Runs pane
TheRecent Runspane shows all the available recorded recent runs based on the selected
user preferences. The following table describes how to use Recent Runs to locate and
open a result.

ActionStep

Click the Recent Runs tab in the Result Navigator.1

Result: The Recent Runs pane opens.

Note:

Until the files and chromatograms in the list have been opened and saved
manually, they are noted in bold text. When they are opened and saved the
text is changed to plain text.

If needed, click Refresh.2

Result: The Recent Runs list is updated with all runs that were performed
since the Result Navigator was opened the last time.

Locate and double-click the desired result.3

Result: The result opens in the Evaluation Classic module.

Click the + signs to view or select individual chromatograms from the results.
Individual results can be selected and removed from the list by clicking Re-
move.Remove all clears the whole list. Remove and Remove all only clear
the list, the results are not deleted.

Note:
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Recent Runs preferences
The Result Navigator will display Recent Runs based on the individual user preference
settings. The table below describes how to adjust the preference settings:

ActionStep

Click Preferences.1

Result: The Preferences dialog box opens.

• Type the maximum number of results to keep on the list.

• Type the maximum number of days to keep the results on the list.

2

Select which results to display on the list:3

• Only results created by the current user.

• All results created by specified users.

Note:

Click Specify to open a dialog box and select froma list with all accessible
users.

• All accessible results regardless of the creator.

• Click Remove results when saved if the results are to be removed from
the list when they have been saved.

• Click OK.

Result: All new results will be displayed on the Recent Runs list based on the
changed preferences.

4
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Search for results using Find
Results

The Find Results function in theResult Navigator is used to locate results in the available
folders.

There is also a common Find function which is available in the Editmenu of
all modules except the Administrationmodule.

Note:

The table below describes how to use the Find function to locate and open a result.

ActionStep

• Click the Find Results tab

Result: The Find Results pane opens.

1

• Type a result name or part of a result name in the Result name box.

Note:

The standard wildcard character * can be used to represent a number of
characters before or after the partial result name.

or

• Type a Sample ID value in the Value of variable Sample_ID box.

Note:

A Sample ID can be set in the Start Protocol. The defined variable name
must begin with Sample_ ID.

2
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ActionStep

• Click Find.

Result: The located results are listed.

Note:

A search for DoE* as in the example below, will only find results that include
the text DoE, not Design of Experiments results.

3

• Double-click the desired result or chromatogram

Result: The file or chromatogram opens in the Evaluation Classic module.

4

ClickAdvanced Find formore advanced search functions, which are described
in the following topic.

Note:
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Search for result files using
Advanced Find Results

The table below describes how to use the Advanced Find Results function to locate and
open a result file.

ActionStep

• Click Advanced Find

Result: The Advanced Find Results dialog opens.

1

• Click Browse to display the folder structure in a Browse Folder dialog,
and click a top folder to search in.

Note:

Your home folder will be selected by default.

• Type a file name or part of a file name in the Result name box.

Note:

The standard wildcard character * can be used to represent a number of
characters before or after the partial file name.

2

• Select if the search shall Include subfolders.

• Select if the search shall be limited to a range of creation dates.

3
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ActionStep

If desired, specify Result content to search for results containing:4

• Questions (as defined in the Start Protocol)

• Answers (as defined in the Start Protocol)

• Variable (specific names)

• Value (specific variable values)

• Batch ID (specific values)

Result: The file or chromatogram opens in the Evaluation Classic module.

• Click Find.

Result: The located files are listed in the Find Results pane.

• Click Close to close the Advanced Find Results dialog.

5

Previous search qualifiers can be found in the lists by each text box. The
qualifiers are listed in reverse order with the latest qualifier on top:

Note:

Close the navigator pane
To close the navigator pane:

• Click the small cross in the top right-hand corner of the navigator.

Result: The navigator closes.
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4.3 Optimize the presentation of chromatograms

About this section
This section describes some of the ways you can optimize the presentation of a chro-
matogram.

In this section
This section contains these subsections:

See pageSection

414.3.1 Customize the chromatogram layout

464.3.2 Edit curve presentation

514.3.3 Change the axes

554.3.4 Enter and edit text in chromatograms

574.3.5 Save and apply layouts
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4.3.1 Customize the chromatogram layout

Introduction
TheCustomize dialog box is used to make changes regarding chromatogram presenta-
tion. The main features of the Customize dialog box regarding chromatograms are de-
scribed in the subsequent sections in this chapter. Features regarding peak tables are
described in Section 5.2 Peak integration, on page 102.

Instruction
The folowing table describes how to make changes in the Customize dialog box:

ActionStep

Open a result.1

• Right-click the chromatogram and click Customize

or

• Click Customize on the Tools menu

or

• Click the Customize toolbar button.

Result: The Customize dialog box is displayed.

2
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ActionStep

• Carry out the changes on the different tabs to get the desired layout for
header, curves and peak table.

• Select Apply to all chromatograms if you want to apply changes made
in the Customize dialog to all open chromatograms.

3

Click OK to apply the changes.4
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Tabs in the Customize dialog
The folloeing table lists the tabs of theCustomizedialog and outlines the editing functions
of each tab.

Use this tab to...Tab

select the items to be displayed in the header field above
the curves:

Header

• Scouting variables

• Variables

• Questions

• Notes

select how the curve names are displayed. This is de-
scribed in detail in Section 4.3.2 Edit curve presentation,
on page 46.

Curve Names

determine how the Y-axis is displayed. This is described
in detail in Section 4.3.3 Change the axes, on page 51.

Y-axis

determine how the X-axis is displayed. This is described
in detail in Section 4.3.3 Change the axes, on page 51.

X-axis

select the curves to display in the chromatogram.Curve

select the Peak Table settings. This is described in detail
in Section 5.2.3 Display peak data, on page 108.

Peak Table

determine how the curves are displayed. This is described
in detail in Section 4.3.2 Edit curve presentation, on
page 46.

Curve Style and Color

edit any text that has been added to the chromatogram.
This is described in detail in Section 4.3.4 Enter and edit
text in chromatograms, on page 55.

Edit Texts
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Use this tab to...Tab

• select and apply a saved chromatogram layout

or

• delete a saved layout

or

• save the current layout.

This is described in detail in Section 4.3.5 Save and apply
layouts, on page 57.

Layout Library

You can select to apply the settings in all tabs to all open chromatograms,
with the exception of text. Text entries can only be applied to the current
chromatogram.

Note:

Layout options in the right-click
menu

You can also change the chromatogram layout by clicking some menu items from the
right-click shortcut menu. The following table describes the layout options available on
this menu:

when you want to...Click...

add a grid to the background of the chromatogram.Grid

add a list of all available curves to the chromatogram,
with checkboxes to select the curves to display:

Filter Curves

Note:

Click the arrow buttons to show additional curves that do
not fit in the available space.
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when you want to...Click...

show only the active curve in the chromatogram.Select Active Curve
Only (this option is available only when Filter Curves is selected)

show all curves in the chromatogram.Select All Curves

(this option is available only when Filter Curves is selected)

show the list of all displayed curve names over the curve
area of the chromatogram.

Legend

select the unit of the X-axis.• Time

or

• Volume

or

• Column volume
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4.3.2 Edit curve presentation

Select curves to display
The Curve tab of the Customize dialog contains a list of all the curves included in the
chromatogram. Select the curves you want to display in the chromatogram, and click
OK.

Curve name appearance
You select options for the curve name appearance on the Curve Names tab. This is an
example of a default curve name:

ID101 a001:1 UV 1_280

The table below describes the three components that make up the default curve name:

ExampleDescriptionComponent

ID001 a 001Name of the result. This is defined by the
settings in the Result Name & Location
dialog in the Method Editor.

Result name

1Number given automatically during a run.Chromatogram
name

UV 1_280Curve type, for example a monitor signal.Curve name

A chromatogram namemay also be defined in the New Chromatogram text
instruction.

Note:

Choose curve nameappearance
You can choose to view only part of the curve name. The table below describes how to
do this:

ActionStep

Open the Customize dialog.1

Click the Curve Names tab.2

Select the appropriate boxes for Curve name appearance.3

Click OK.4
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It is usually sufficient to select the Curve Name option if only one chro-
matogram is being evaluated. However, confusion can arise whenmore than
one chromatogram is shown, so more complete names might be necessary.

Note:

Curve style and color settings
All curves within a chromatogram are represented by a default color and line style.
Curves that are imported into the chromatogram or newly created curves are automat-
ically assigned a color and line style. The settings are available in the Curve Style and
Color tab. The tab also contains settings for peak labels, fraction marks and run log texts.

Change the color and style of a
curve

The table below describes how to change the color and style of a curve:

ActionStep

Open the Customize dialog.1

Click the Curve Style and Color tab.2

• Click the curve you want to change from the list.

• ClickColor to open theColor dialog and choose a color from the palette.

• Click a button to choose a Line style.

• Repeat step 3 to modify other curves.

3

Click OK to apply the changes.4
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Peak labels
Peaks can be labeled on the Curve Style and Color tab. A combination of the following
labels can be selected:

• Number

• Peak Name

• Retention (the default label).

You can also select Vertical or Horizontal alignment for the text.

You will need to perform a peak integration and create a peak table before
the labels are displayed. The peak name is entered in the peak table. This is
described in Section 5.2.4 Edit the integration parameters, on page 112.

Note:

Align Fraction and Run log texts
Both Fraction and Run log text can be set either to be displayed when the mouse
pointer is positioned over a fraction mark (Fly over only) or at all times. The Fraction text
can be aligned both vertically and horizontally. Default setting for both text types is
Vertical. TheVertical selection forRun log text is the setting to show the text at all times.

Filter Run log information
The following table describes how to select the Run log entry and feedback types to
show in the chromatogram:

ActionStep

Open the Customize dialog.1

Click the Curve Style and Color tab.2
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ActionStep

Click Filter in the Run log text alignment field.3

Result: The Filter Run log dialog opens.

• Select the entry types to show in the chromatogram.

• Select the feedback types to include in the run log entries.

• Click OK.

Result: The Filter Run log dialog closes.

4

Click OK in the Customize dialog to apply the changes.5
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Add a grid
You can add a grid to the background of the chromatogram by selecting the Grid
checkbox.

You can also right-click in the chromatogram and click Grid on the shortcut
menu.

Note:
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4.3.3 Change the axes

Introduction
This section describes how to change the chromatogram axes according to your prefer-
ences. These changes are made in the Y-axis and X-axis tabs of the Customize dialog.

Change and fix the Y-axis
The following table describes how to change and fix the scale of the curves in the chro-
matogram Y-axis:

ActionStep

Click the Y-Axis tab.1

• Select the appropriate curve from the list.

• Click Fixed in the Scale for curve number field.

2
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ActionStep

• Type the desired minimum and maximum values.

• Click All with this unit if you want other curves with the same Y-axis
units as the current scaled curve to be similarly scaled.

Note:

The values will only be applied to existing curves. They will not be applied
to new curves created after this function was last used.

3

Click OK to apply the changes.4

Select Y-axes to display
The following table describes how to select the Y-axes to display in the chromatogram.

ActionStep

Click the Y-Axis tab.1

• Click a curve for the left Y-axis in the Left Axis list.

• If you want to add a second Y-axis, proceed with step 3. If not, jump to
step 4.

2

Click a second curve from the Right Axis list.3

Click OK to apply the changes.4
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Change and fix the X-axis
The following table describes how to change and fix the scale of the X-axis in the Cus-
tomize dialog:

ActionStep

Click the X-Axis tab.1

Click the appropriate option in the Base field:2

• Time

• Volume

• Column Volume

Note:

Some calculated curves, for example baselines, exist in only one base and
might seem to disappear when the base is changed. Curves are collected in
time and recalculated for display in volume. Thus, switching the base between
Time and Volume can slightly alter the resolution of the displayed curves.
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ActionStep

• Click the Fixed option in the Axis scale field to set the axis limits manu-
ally.

• Type the desired minimum and maximum values.

• If desired, select theAdjust retention zero to injection number checkbox
and click an injection number in the list.

Note:

This sets the time/volume to zero at the selected injectionmark. The time
and volume before selected injection will become negative values.

3

Click OK to apply the changes.4
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4.3.4 Enter and edit text in chromatograms

Introduction
This section describes how to enter and edit text annotations in the curve field of the
chromatogram. The text is applicable to the active chromatogram.

Enter annotation text
The following table describes how to enter annotation text in the chromatogram:

ActionStep

• Right-click the curves view of the chromatogram window and click Add
text on the menu.

or

• On the Edit menu, click Text and then click Add.

1

• Click where you want to insert text in the chromatogram.

Result: A text box opens.

2

• Double-click inside the text box.

• Type the new text.

• Click outside the text box to set the text.

Note:

You can select and drag the text box to a new position with your mouse
pointer.

3
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Edit annotation text
The following table describes how to edit inserted annotation text:

ActionStep

On the Edit menu, click Text and then click Add.1

Result: The Edit Texts tab of the Customize dialog is displayed.

• Select the text that you want to edit and make the appropriate changes
in the Selected text field.

• Click Change text or Delete text.

2

Click OK to apply the changes.3

Shortcut option
You can also double-click inside the text box to select the text. Then you can

• type new text

and

• click outside the text box to set the new text
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4.3.5 Save and apply layouts

Introduction
All configurations that you make in the Customize dialog can be saved as a layout. It is
possible to apply saved layouts to other chromatograms. Layouts can either be saved
as personal layouts for your own use only, or as global layouts that are available for
everybody with network access. You may also save a layout as your default setting. The
default layout will be applied automatically when you open a result.

Save a layout
The following table describes how to save a layout:

ActionStep

Open the Customize dialog.1

• Make the appropriate layout configuration within the various tabs.

• Click OK to see the applied affects of your changes.

• Return to the Customize dialog box to perform further changes.

2

Click the Layout Library tab when you are satisfied with the layout.3
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ActionStep

Click Save Current Layout As.4

Result: The Save Layout dialog box is displayed.

• Type a name for the layout in the Save layout as box.

• Select if the layout should be Global or Personal.

• If you want the current layout to be the new default layout, select the
Save as default checkbox.

Tip:

The default layout will be applied automatically when you open a result.

5

Click OK to save the layout and close the Save Layout dialog.6

Result: The new layout name is added to the Saved layouts list.

Click OK to close the Customize dialog.7

Apply a layout
The following table describes how to apply a saved layout:

ActionStep

Click the Layout Library tab in the Customize dialog.1
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ActionStep

• Select a layout from the Saved layouts list.

• If necessary, select which layouts to show in the Filter layouts field.

Note:

Personal layouts are noted with a (P), global layouts with a (G).

• Click Apply selected layout.

2

If the same layout is to be applied to all chromatograms on the Evaluation
workspace, select the Apply to all chromatograms checkbox.

3

Click OK to close the dialog and apply the changes.4
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4.4 Print chromatograms and peak data

Introduction
This section describes how to print the chromatograms that are open in the Evaluation
Classic module.

ThePrint Chromatogramsdialog
box

Following is an illustration of the Print Chromatograms dialog.

The selected print format is outlined in red.Note:

Instruction
The following table describes how to print active chromatograms on the default Windows
printer.

ActionStep

Open all chromatograms that you want to print in the Evaluation Classic
module.

1
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ActionStep

• On the File menu, click Print.

or

• Click the Print result button.

Result: The Print Chromatograms dialog opens.

2

Select print format and layout options.3

• Click OK to open the Print dialog and proceed with step 8.

or

• Proceed with step 5 to preview and edit the layout.

4

Click Preview.5

Result: The Customize Report window opens.

• Click Edit Mode to make changes, for example to change the order of
the chromatograms (see Section 4.6.2 Create a new report format, on
page 79 for more information about how to edit).

• Click Preview to return to preview mode.

Note:

You can print directly from the Customize Reportwindow or click Exit to re-
turn to the Print Chromatogram dialog.

6
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ActionStep

• On the File menu, click Print.

or

• Click the Print button.

Result: The Print dialog opens.

7

• Select the print range and number of copies.

• If necessary, click Properties to open the printer properties dialog where
the settings for your printer can be changed.

• Click OK to print the chromatograms.

8
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4.5 Run documentation

Introduction
The full documentation for a method run is stored in the result. This section contains:

• an instruction how to view and print the run documentation,

• a list and short descriptions of the contents of the run documentation,

• an instruction how to save the text instructions from the run as a new method.

View and print the run
documentation

The following table describes how to view and print the run documentation.

ActionStep

Open a result in the Evaluation Classic module.1

• On the View menu, click Documentation

or

• Click the Documentation button.

Result: The Documentation dialog opens.

2

See further information about the tabs and contents below.

• Click Print.

Result: The Print dialog opens.

3
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ActionStep

• Select the documentation items you want to print.

Note:

Items that do not contain any information cannot be selected. If you select
a group heading (e.g., Result information) all sub-headings that contain
information will automatically be selected.

4

Click OK to print the selected items.5

The Documentation tabs
The following table describes the contents of the Run Documentation tabs.

Someof the items listed belowmaybe excluded from theRunDocumentation.
Tabs will only be shown if the item exists in the result.

Note:

ContentsDocumentation tab

The Result Information tab contains general information
about the result.

Result Information

See "The Result Information tab" in this section.
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ContentsDocumentation tab

The Evaluation Procedures tab shows all procedures that
have been run during or after the method run. See Sec-
tion 7.3 Automated evaluation procedures, on page231 for
information about how to work with evaluation proce-
dures.

Evaluation Procedures

TheMethod Information tab shows the generalProperties
of the method:

Method Information

• Name

• When and by whom the method was created

• When and by whom the method was last modified

• The system and Instrument Configuration that the
method was created for

Click Details to view comprehensive information about
the Instrument Configuration.

The Method Information tab also contains a listing of all
the electronic signatures that have been added to the
method, under the sub-tab Signatures.

The Start Protocol tab shows the method items that were
included in the Start Protocol at the start of the method
run.

Start Protocol

The System Information tab shows the system settings
during the method run, for example

System Information

• UV, conductivity and pH settings

• Pumps and pressure settings

• Air sensor settings, watches and alarms

• Fraction collection settings

The Calibration tab shows a calibration report for the
system.

Calibration

TheRun Log tab shows selected log entries and feedback.Run Log

See "The Run Log and Evaluation Log tabs" in this section.
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ContentsDocumentation tab

The Evaluation Log tab lists all of the evaluation opera-
tions that have been performed for the result during all
sessions, including at the end of the method run. The log
also shows when the result has been accessed without
editing after the end of the method run.

Evaluation Log

See "The Run Log and Evaluation Log tabs" in this section.

The Fraction Collector tab shows an image of the cas-
settes, tubes and well plates used in the fraction collector.
This tab is only shown if fractionation has been chosen
as a component in System Properties in the Administra-
tion module.

Fraction Collector

(system specific)

The Variable List tab shows all the method variables and
corresponding values, listed by the method block where
they appear.

Variable List

The list can show detail and/or unused variables. At this
stage, the variable values are no longer possible to edit.

The Scouting tab shows the scouting parameter settings.
This tab corresponds to the Scouting settings in the
Method Editor.

Scouting

The Text Instructions tab shows all the text method in-
structions from the method.

Text Instructions

These instructions can be saved as a new method. This is
described in "Save the method used for the run as a new
method" in this section.

The Notes tab shows all notes that have been made re-
garding the method, the method run and the subsequent
evaluation. The notes are divided into the following sub-
tabs:

Notes

• Method Notes

• Start Notes

• Run Notes

• Evaluation Notes

You can add new notes on the EvaluationNotes sub-tab.

Note:

Click Find to search for specific text in the Notes.
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ContentsDocumentation tab

TheBufferPro tab shows theBufferPro settings, including
the recipe settings, the stock solutions and a general de-
scription.

BufferPro

(system specific)

The Columns tab shows information about the columns
used during the method run. It contains two sub-tabs:

Columns

Column type

The Column type tab shows general information about
the type of column that has been used, including:

• general Run Parameters

• column Details (dimensions, volumes, bed heights,
etc.)

• Ordering Information

Column

If Column logbook is enabled the Column tab shows spe-
cific information for the column that has been used, includ-
ing:

• ID numbers

• Media Batch ID and expiration date

• number of runs the column has been used for

• results from performance tests
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The Result Information tab
The table below describes the sub-tabs and contents of the Result Information tab:

ContentsResult Infor-
mation sub-
tab

The Properties sub-tab shows general information about the result:Properties

• Name

• Batch ID

• When and by whom the result was created

• When and by whom the result was last modified

• The system and Instrument Configuration that was used for
the method run

Click Used Components to view a list of all components and moni-
tors that were used for the run.

Click Details to view comprehensive information about the Instru-
ment Configuration.

The Signatures sub-tab contains a listing of all the electronic signa-
tures that have been added to the result.

Signatures

The Run Summary sub-tab (illustrated next) shows a summary of
the run expressed in volume or time per phase and block.

RunSummary

The phases and method blocks within the phases are shown as
they appear in the Text Instructions.

The method base can be toggled between time and volume by
clicking Time or Volume.

The Snapshots sub-tab shows all snapshots that have been taken
during the run.

Snapshots

The Name and Location sub-tab shows the search path to the re-
sult, as an image of the folder structure where the result is saved.

NameandLo-
cation

This sub-tab corresponds to the Result Name and Location dialog
in the Method Editor.

TheDataMigration sub-tab shows details on the result data migra-
tion.

Data Migra-
tion
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The System Information tab
The table below describes the sub-tabs and contents of the System Information tab:

ContentsSystem Information sub-
tab

The complete list of system settings is shown here, in-
cluding for example:

System Settings

• UV settings

• Conductivity settings

• pH alarm settings

• Pumps and pressure settings

• Air sensor settings

• Fractionation settings

• Watch settings

etc.

The operational statistics for the instrument compo-
nents are shown here, for example:

Operational Statistics

(system specific)

• UV Cell component Id number

• UV lamp run time

• Mixer component Id number

• Number of pump strokes

• Valve operations

etc.

The UV cell and Mixer specifications are shown here,
including

Mixer Size and UV Cell
Path Length (system spe-
cific)

• UV cell path length

• Mixer volume
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The Run Log and Evaluation Log
tabs

The Run Log and Evaluation Log are similar but cover different process cycles.

Run Log
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The Run Log shows settings and events from the initial start of the method run up to
the end of the run.

The displayed run log can be filtered to show only selected entry and feedback types.
TheBase can be shown either as Time orVolume and the retention zero can be adjusted
to a selected injection.

Evaluation Log

The Evaluation Log is initiated by the first evaluation action and additional entries are
added every time the result is accessed.

The evaluation operations are listed in the order that they have been performed. The
date, time and time zone is shown for each entry.

Search for log entries
The following table describes how to find specific text in the logs.

ActionStep

Select the log tab where you want to perform your search.1
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ActionStep

• Click Find.

Result: The Find dialog opens.

2

• Type the text you want to locate in the Find what box.

Note:

Your previous search text may be shown in this box if you have used the
search function before.

• Select additional search criteria:

- Match whole word only

- Match case

- Search up

- Search down

3

• Click Find Next.

Result: The first log entry where the search text is found is marked.

4

Save themethodused for the run
as a new method

You can save the method and the variables that were used for the run as a new method
as described in the following table.

It is not possible to re-create a method in UNICORN 7.0 from a result that has
been migrated from UNICORN 5.

Note:

ActionStep

Click the Text Instructions tab.1

• Click Save as.

Result: The Save As dialog box opens.

2
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ActionStep

• Select the appropriate destination folder.

• Type a name in the Name box.

• Click a system in the System list.

3

• Click OK.

Result: The method is saved.

4
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4.6 Generate reports

About this section
The Evaluation Classic module provides extensive tools to create detailed reports. This
section describes how to create and print reports and how to customize the report lay-
outs.

In this section
This section contains these subsections:

See pageSection

764.6.1 Generate and print a predefined report format

794.6.2 Create a new report format

954.6.3 Edit an existing report format
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4.6.1 Generate and print a predefined report format

Introduction
This section describes how to generate and print a report using a format that has been
defined and saved.

Should you need to store your reports in an electronic format you can also save them
as PDF files. This section describes how to do this.

Generate and print the report
The following table describes how to select a format and print the report:

ActionStep

• On the File menu, click Report

or

• Click the Report button.

Result: The Generate Report dialog opens.

1

• Select the Format for the report by clicking the format name.

Note:

Global report formats are noted by the text "Global" before the report
format name in this list.

2
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ActionStep

• Click Preview to view the report in the Customize Report window and
click the Print button

or

• Click Print in the Generate Report dialog.

Result: The Print dialog open

3

• Click a printer in the Printer list.

• Select a Print Range, all pages or just selected pages.

• Select a number of copies.

4

• Click OK.

Result: The report is printed on the selected printer.

5

Click Editmode in theCustomize Report dialog to change the layout. You can
either print the edited format from thismode and close the Customize Report
dialogwithout saving the changes or save the editswhen you close the dialog.

Note:

Save the report in PDF format
The generated report can be saved as a PDF file, regardless if Adobe™ Acrobat™ is in-
stalled on the computer or not. The two alternatives for saving the report are described
below:

Save the report with Adobe Acrobat installed

ActionStep

Perform steps 1 to 3 in the "Generate and print the report" instruction above.1
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ActionStep

• Click an Adobe PDF printer on the Printer menu.

Note:

You must have a full installation of Adobe Acrobat or a suitable PDF creation
application to be able to do this.

6

• Click Properties and edit the document properties if needed.

• Select the print range and number of copies.

7

• Click OK.

Result: The report is created as a PDF file and saved in the location specified
in your Acrobat settings.

8

Save the report without Adobe Acrobat installed

ActionStep

Perform steps 1 to 2 in the "Generate and print the report" instruction above.1

Click Preview to view the report in the Customize Report window9

On the File menu, click Save As PDF.10

Result: The Save As dialog opens.

• Browse for a folder and enter a File name for the report.

• Click Save.

Result: The report is created as a PDF file and saved in the location specified
in the dialog.

11
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4.6.2 Create a new report format

Introduction
This section describes how to create a new, customized report format. You can choose
from a variety of objects to include in a report, including chromatograms, methods,
documentation, free text and more. You can also place, align and size the objects as you
please.

Click Preview/Edit mode to toggle between the Previewmode which is for
view only, and the Edit modewhere you can edit the report items. The editing
actions in this section are only available in the Edit mode.

Note:

Open the Customize Report
window

The following table describes how to open the Customize Report in Edit mode to create
a new report format.

ActionStep

Open a result in the Evaluation Classic module.1

• On the File menu, click Report.

or

• Click the Report button.

Result: The Generate Report dialog box opens.

12

• Click New.

Result: The Customize Report window opens in Edit mode.

13
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The Edit mode window
The following illustration shows theCustomize Reportwindow in Editmodewith a blank
report open:

Toolbar buttons in theCustomize
Report window

The following table describes the different functions of the toolbar buttons in the Cus-
tomize Report window:

FunctionToolbar button

This button toggles between a print preview of the report
and the Edit mode.

Preview/Edit mode

This button displays the previous page or pair of pages (if
there is more than one page).

Prev Page

This button displays the next page or pair of pages (if there
is more than one page).

Next Page
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FunctionToolbar button

This button toggles between single page view and pairs
of pages view (if there is more than one page).

One Page/Two Pages

Select the magnification of the view in this list.

This button adds a blank page to the report.Add Page

This button deletes the current page from the report.Delete Page

This button closes the Customize Report window.Exit

The general toolbar buttons are described in the following topic. The toolbar
button for specific formatting operations are described in the instructions for
how to use the functions.

Note:

General toolbar buttons
The following table describes the different functions of the general toolbar buttons in
the Customize Report window:

FunctionToolbar icon

Opens a new, blank report.

Note:

You can also choose the File:Newmenu command.

Opens the Open Report Format dialog. You can choose
to open a previously defined format for editing.

Note:

You can also choose the File:Openmenu command.
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FunctionToolbar icon

Saves the edited report format.

Note:

You can also choose the File:Savemenu command.

Cuts the selected object from the report.

Note:

You can also choose the Edit:Cutmenu command.

Copies the selected object in the report.

Note:

You can also choose the Edit:Copymenu command.

Pastes a copied or cut object from the clipboard into the
report.

Note:

You can also choose the Edit:Pastemenu command.

Add or delete report pages
The following table describes how to add or delete report pages:

then...If you want...

• click Add Page.

Result: A new page is added after the last page.

to add new pages,

• select the page with Next Page or Prev Page,

• click Delete Page and confirm the deletion.

to delete a page while
in One Page mode,

• select the page with Next Page or Prev Page,

• click an object on the page,

• click Delete Page and confirm the deletion.

to delete a page in Two
Page mode,

Note: • On the Editmenu, click Delete or press the Delete key to delete objects,
not whole pages.
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• The number of pages in the Edit mode does not always correspond to the
number of printed pages. Click Preview in the toolbar for a print preview.

Change the page layout
The page layout is changed in the Page Setup dialog. The following table describes how
to set up the page layout:

ActionStep

• Double-click anywhere on the report page (not on an object)

or

• Right-click (not on an object) and click Properties on the shortcut menu

or

• On the Edit menu, click Page setup.

Result: The Page Setup dialog box opens.

1

• Type new values for the Margins if necessary.

• Click the appropriate Settings and Units.

Note:

An extra Header tab will appear if you clear the Same header on all pages
checkbox. The First Header tab is used for the first page header only, and the
Header tab is used for all subsequent pages.

2
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ActionStep

• Click the First Header tab.

• Select all the items you want to include in the header from the Select
Items list.

• Click Font to change the font for all items if necessary.

3

• Type header text in the Free text box and click Font to alter the default
font if necessary. This text will be placed on top of the header.

• Type the report title in the Report title box and click Font to alter the
default font if necessary. The title is centered immediately above the
page contents.

4

If you want to have a line under or over the header, select the appropriate
option in the Layout field.

5

• Repeat steps 3 to 5 on the Footer tab and the subsequent pagesHeader
tab.

Note:

AllHeader and Footer tabs contain the same options. You can have all infor-
mation in either the header or footer or split information between the header
and footer as required.

6

Click OK to apply the changes.7

Add objects to the report
The following table describes how to add objects to the report. The various objects are
described in the next topics.

ActionStep

• Click the appropriate button in the Report items toolbar.

or

• Click an object on the Insert menu.

1
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ActionStep

• Press and hold the left mouse button on the report page, and drag out
a box to the size of the item you want to insert.

Note:

Themouse pointer shows a symbol for the type of item you have selected.

• Release the mouse button.

Result: A Setup dialog opens. The dialog is specific to the type of item that
you want to insert.

2

• Select the desired Settings, for example Start on new page, and click
OK.

Result: The object is inserted onto the page.

3

Note: • If you want to edit an object later, double-click the object box.

• The size of the object in Edit mode does not always correspond to the size
in the printed report. Click Preview for a print preview.

Add free text
The following table describes how to add free text to the report:

ActionStep

• Click the Free Text button.

• Press and hold the left mouse button on the report page and drag out
a box to the size of the text. Release the button.

Result: The Setup Free Text dialog box opens.

1

Type text in the edit field.2

Select the appropriate Settings:3

• Start on new Page: the text is to start on a new page

• Size to content: the text box should be automatically sized

• This position on all pages: the text should appear in the same position
on all pages, for example as header and footer text.
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ActionStep

• Click Font to change the default font.

Result: The Font dialog box opens.

4

• Make the necessary changes and click OK to return.

• Click OK

Result: The text object is inserted onto the page.

5

Add a picture
The Picture dialog box is useful to insert logos, pictures or other figures in the report.
The following table describes how to add a picture object to the report:

ActionStep

• Click the Picture button.

• Press and hold the left mouse button on the report page and drag out
a box to the size of the picture item. Release the mouse button.

Result: The Setup Picture dialog opens.

1

• Click Browse to locate the desired picture file.

• Select the picture file and click Open.

Note:

A number of image file formats are supported, for example .bmp, .gif,
.emf, .jpg and .tif.

Result: A preview of the selected picture is displayed.

2

• Select the desired Settings (Start on new Page, Size to content).

• Click OK.

Result: The picture is inserted onto the page.

3
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Add a chromatogram or peak
table

The following table describes how to add a chromatogram and/or peak table to the report.

ActionStep

• Click the Chromatogram button.

• Press and hold the left mouse button on the report page and drag out
a box to the size of the chromatogram/and or peak table. Release the
mouse button.

Result: The Setup Chromatogram dialog opens.

1

Click which chromatogram(s) to insert in the Selected chromatogram(s) list.2

• Active chromatogram inserts the chromatogram that currently is active
in the Evaluation Classic module.

• All chromatograms inserts all chromatograms that are open in the
Evaluation Classic module.

• 1, 2...etc., inserts the corresponding chromatogram.
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ActionStep

• Select the desired Settings.

• If desired, change the Fonts.

Note:

Separate fonts can be selected for the Chromatogram, the Peak table
and the Header text.

3

• Click Define in the Layout field if you want to re-define the layout of the
chromatogram.

Result: The Report Customize dialog box opens.

4

• Make the appropriate changes and click OK to return to the Setup
Chromatogram dialog box.

Note:

- All curves can be de-selected in the Report Customize dialog box
leaving only the selected peak table(s) in the report.

- The changes that you make will only affect the report and not the
view of the chromatograms in the Evaluation Classic module.

Tip:

If selecting Current layout, the chromatogramwill appear as in the Eval-
uation window, for example with the current zooming.

Click OK.5

Result: The chromatogram is inserted onto the page.
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Include a method
The following table describes how to include a method in the report:

ActionStep

• Click the Method button.

• Press and hold the left mouse button on the report page and drag out
a box to the size of the item. Release the button.

Result: The Setup Method dialog opens.

1

Select the items to be included in the report:2

• Main Method is the method on which the run was based.

• Blocks are the blocks that were used in the method.

• Select the appropriate Settings (Start on new page, Expand main).

Note:

Expand main displays the expanded method view.

• If desired, change the Fonts for the Title and Text.

3

• Click OK.

Result: The method object is inserted onto the page.

4
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Add documentation
The table below describes how to add documentation to the report:

ActionStep

• Click the Documentation button.

• Press and hold the left mouse button on the report page and drag out
a box to the size of the item. Release the button.

Result: The Setup Documentation dialog opens.

1

Select the items to be included in the report:2

• Select All includes all items in the report.

• Clear All removes all selections.

• If desired, change the Fonts for Title or Text.

• Select if the documentation should start on a new page.

3

• Click OK.

Result: The selected documentation items are inserted into the report.

4
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Add the Evaluation Log
The following table describes how to add the Evaluation Log to the report:

ActionStep

• Click the Evaluation Log button.

• Press and hold the left mouse button on the report page and drag out
a box to the size of the item. Release the mouse button.

Result: The Setup Evaluation Log dialog opens.

1

• If desired, change the Fonts for Title or Text.

• Select if the Evaluation Log should start on a new page.

2

• Click OK.

Result: The Evaluation Log is inserted into the report.

3

Move and resize objects freely
The following table describes how to select, move and resize objects freely:

then...If you want to...

• click the Select button,

• click the object of interest.

select a single object,

• click the Select button,

• press and hold theCtrl key while you click the objects.

select several objects,

click on the objects, hold down the left mouse button and
drag the object(s) to the new position.

move the selected
object(s),
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then...If you want to...

click one of the object border anchors, either in the corners
or in the middle of a border, and drag the box to the new
size.

Note:

Some Text objects cannot be resized.

resize the selected
object(s),

Alignment toolbar buttons
Objects can be placed in exact positions and sized in relation to other objects. The table
below describes the function of the Alignment toolbar buttons in the Report Editor:

FunctionToolbar button

Align left

Matches the left alignment of all selected objects to that
of the highlighted object.

Align right

Matches the right alignment of all selected objects to that
of the highlighted object.

Align top

Matches the top alignment of all selected objects to that
of the highlighted object.

Align bottom

Matches the bottom alignment of all selected objects to
that of the highlighted object.

Adjust to margins

Stretches the selected object(s) to the left and right mar-
gins.

Adjust to left margin

Adjusts the selected object(s) to the left margin.
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FunctionToolbar button

Adjust to right margin

Adjusts the selected object(s) to the right margin.

Adjust to center

Adjusts the selected object(s) to the center of the page.

Make same size

Adjusts the selected objects to the same size as the high-
lighted reference object.

Make same width

Adjusts the selected objects to the same width as the
highlighted reference object.

Make same height

Adjusts the selected objects to the same height as the
highlighted reference object.

TheMake same size andMake samewidth buttons can only be used to resize
the width of chromatograms, free text and picture objects.

Note:
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Save the report format
The following table describes how to save the finished report format:

ActionStep

• On the File menu, click Save.

or

• Click the Save button.

Result: The Save Report Format dialog box opens.

1

• Type a name for the format.

• Select if you want to save the format for global use.

• Select if you want to save the format as default.

Note:

The name for the default format will automatically be changed to

DEFAULT.

2

• Click OK to save the format.3
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4.6.3 Edit an existing report format

Introduction
This section describes how to edit an existing report format.

By clicking the Preview/Edit mode button, you can toggle between a print
preview of the report and an editing mode. The editing actions are only avail-
able in the Edit mode.

Note:

Edit a saved report format
The following table describes how to edit a saved report format in the Evaluation Classic
module.

ActionStep

Open a result file.1

• On the File menu, click Report

or

• Click the Report button.

Result: The Generate Report dialog opens.

2

• Select a report format to edit.

• Click Edit.

Result: The Customize Report window opens.

3

• Make the necessary changes to the report format.

Note:

Once you have made a change, the title bar of the window will add the
word Modified to the report format name.

4
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ActionStep

• On the File menu, click Save

or

• Click the Save button.

Result: The edited format is saved.

5

To return to the Evaluation Classic module window:6

• On the File menu, click Exit

or

• Click the Exit button.

• Click Close to close the Generate Report dialog.

or

• Select another report format to edit.

7

See Section 4.6.2 Create a new report format, on page 79 for instructions
about how to add or edit report items. You can also click Save As on the File
menu in the Customize Report window, to save the edited format under an-
other name and keep the original report format unchanged.

Note:

96 UNICORN 7.0 Evaluation Manual 29-1108-88 AA

4 View and present the results
4.6 Generate reports
4.6.3 Edit an existing report format



5 Evaluate results

About this chapter
This chapter describes how to perform a number of editing and evaluation operations
on your results, for example:

• peak integrations

• baseline operations (editing and optimization)

• fraction and peak operations (how to pool fractions, etc.)

• comparison of different runs

For information about how to view results, see chapter Chapter 4 View and present the
results, on page23. Curve operations and automated evaluation procedures are described
in chapter Chapter 7 Other evaluation operations, on page 213.

Analysis and evaluation of Design of Experiments results is described in
UNICORN Method Manual.

Note:

In this chapter
This chapter contains these sections:

See pageSection

985.1 Subtract a blank run curve

1025.2 Peak integration

1315.3 Baseline operations

1495.4 Fraction and peak operations

1615.5 Compare different runs

1815.6 Multi Result Peak Compare wizard

1925.7 Rename folders, results, chromatograms, curves and peak tables

1935.8 Sign results electronically

1955.9 Save results
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5.1 Subtract a blank run curve

Introduction
Subtracting a blank run curve is useful to improve the peak integration parameters if
the curves have a drifting baseline or ghost peaks.

Ghost peaks
If the ghost peaks come from impurities in the eluents, all equilibrations of the columns
should be the same from method run to method run. If, for example, the equilibration
volume with buffer A is larger before a blank run curve than before a separation, your
ghost peaks might be higher in the blank run curve. See Section 7.1.2 Reduce noise and
remove ghost peaks, on page 218 for further information.

Example of a UV curve with
baseline

The illustration below shows a UV curve with a baseline, prior to subtraction of the
baseline:
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Example of a UV curve after
subtraction of the baseline

The illustration below shows the UV curve above, after subtraction of the baseline:

How to import a blank run curve
If a blank run curve was made, this might have been stored in another result. The following
table describes how to import the blank run curve:

ActionStep

Ensure that the destination chromatogram has been opened and is the active
tab in the Evaluation Classic module.

1

On the File menu, click Open, then click Curves.2

Result: The Open Curves dialog box is displayed.

Double-click the result that contains the blank run curve.3

Result: The curves in the first chromatogram are displayed.
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ActionStep

• Click the appropriate chromatogram in the Available curves list.

Result: The curves for that chromatogram are displayed in the field below.

4

• Click the curves that correspond to the blank run curve and click the
Select button.

Result: The selected curve is displayed in the Selected curves field.

5

• If you want to remove a curve from the field, click it and then click the
Remove button.

• Click OK to import the curve.

6

If there is no blank run curve available, you can create one by clickingCalculate
baseline on the Integratemenu as described in section Section 5.2.2 Perform
apeak integration, onpage105. Formoredetailed informationonhow to import
curves, chromatograms and other results see Section 5.5 Compare different
runs, on page 161.

Note:
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Subtract the blank run curve
You can subtract the blank run curve or the baseline from the sample curve. The following
table describes how to do this:

ActionStep

On the Operations menu, click Subtract.1

Result: The Subtract dialog box is displayed.

• Select the sample chromatogram and curve in the chromatogram list
and curve field to the left.

• Select the baseline or blank run curve to be subtracted in the middle list
and field.

Note:

The suggested curve number is highlighted in the Target chromatogram
and curve field. A default name is displayed in the Curve name box.

• Click OK.

2

All resulting curves from the subtract operation receive the SUB suffix by de-
fault. The default curve name can be changed as needed in the Curve name
box.

Note:
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5.2 Peak integration

About this section
Peak integration is used to identify and measure a number of curve characteristics in-
cluding peak areas, retention time and peak widths. This section describes:

• how to calculate a baseline, perform the peak integration and display the data

and

• how to perform some special operations, for example peak exclusion.

In this section
This section contains these subsections:

See pageSection

1035.2.1 Baseline calculation

1055.2.2 Perform a peak integration

1085.2.3 Display peak data

1125.2.4 Edit the integration parameters

1245.2.5 Integrate part of a curve

1285.2.6 Exclude or skim peaks
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5.2.1 Baseline calculation

Introduction
The first step when you integrate peaks is to calculate a baseline. A correct baseline is
crucial for accurate calculation of the peak areas. This section describes the options for
how to calculate baselines in the Peak Integrate dialog.

Baseline options
UNICORN offers several options for how to create an accurate baseline:

• To use the automatic Calculate baseline function.

• To create a baseline based on a blank curve.

• To use a Zero baseline.

• To reuse an existing baseline.

The Calculate baseline function
The Calculate baseline instruction provides automatic calculation of the baseline. In
most cases the measurement is very accurate. The calculation can be performed using
the Morphological algorithm or the Classical algorithm.

Baselines basedonablank curve
A blank curve can be used as the baseline for peak integration.

• You can use a blank curve with the same chromatographic conditions as the corre-
sponding sample.

or

• You can subtract the blank run from the source curve and then perform peak inte-
gration on the resulting curve with the Calculate baseline instruction.

In addition to blank run curves, it is also possible to select any curve from the
current chromatogram as the baseline (e.g., an edited baseline.)

Note:
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Zero baseline
To use a Zero baseline means that there is no baseline subtraction at all. The baseline
will be a straight line at the zero level.

Reuse an existing baseline
Using an existing baseline for the selected curve is the default alternative whenever
there is an existing baseline available. The option Correlated baseline is selected if this
is the case.
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5.2.2 Perform a peak integration

Instruction
The following table describes how to perform a basic peak integration.

ActionStep

Open a result file in the Evaluation Classic module.1

• On the Integrate menu, click Peak Integrate.

or

• Click the Peak Integrate toolbar button.

Result: The Peak Integrate dialog opens.

2
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ActionStep

• Select a source chromatogram and curve.

• Click a baseline or a calculation method in the Baseline list.

• Click OK to integrate with the default selections.

or

• Proceed with steps 4 to 6 to change the default selections.

3

• Click Baseline settings to change the calculation algorithm in the Set-
tings dialog box. The default algorithm is Morphological.

• Change the selections or values.

Note:

See also Section 5.3.2 Optimize the baseline with a morphological algo-
rithm, on page136 and Section 5.3.3 Optimize the baseline with a classic
algorithm, on page 140 for more information about how to edit baseline
settings.

• Click OK.

4

• Click Peak window to edit the peak window limits if necessary.

• Click Reject peaks to set the parameters for peak rejection if necessary
(See Section 5.2.6 Exclude or skim peaks, on page 128).

• Edit the Column height (bed height) or Column Vt values if necessary.

Tip:

If a result from an intelligent packing method that includes a packing test is
evaluated, the bed height of the column may have to be adjusted to the
measured bed height to achieve the correct column performance test values.

5

• Click OK to integrate and close the dialog box.

or

• Click Save and Edit Peak Table to save the integration and open the in-
tegrated curve for editing.

- See Section 5.3.1 Edit the baseline manually, on page 132

- See Section 5.2.4 Edit the integration parameters, on page 112

- See Section 5.2.5 Integrate part of a curve, on page 124

- See Section 5.2.6 Exclude or skim peaks, on page 128

6
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Peak integration results
The peak table is displayed underneath the active chromatogram. The start point and
end point of each peak are marked by vertical marks, drop-lines, in the chromatogram.
The peaks are automatically labeled according to what is selected in the Curve Style
and Color tab of the Chromatogram Layout dialog box. A summary of the integration
and the settings used can be viewed by clicking the Integration summary tab.

This is an illustration of the results after a peak integration:

Peak tables can be copied from one chromatogram to another by clicking
Copy between chromatograms on the Editmenu. The copied peak table
name will have the default ending COPY.

Note:
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5.2.3 Display peak data

Introduction
There are a number of options for how to display and edit the peak data and peak table
contents. This section describes some of these options. Other options are described in
Section 5.2.4 Edit the integration parameters, on page 112.

Peak characteristics
The peak retention times and several other peak characteristics are calculated automat-
ically. The following table describes how to display other peak characteristics.

ActionStep

• Right-click in the active chromatogram.

• Click Customize on the shortcut menu.

Result: The Customize dialog opens.

1

Click the Peak Table tab.2
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ActionStep

• Select options from the Select peak table columns list.

• Click OK.

Result: The selected items will be displayed in the peak table.

3

How to filter peaks from view
Peaks can be removed from display in a peak table. The following table describes how
to filter the peaks:

ActionStep

• Right-click in the active chromatogram or peak table.

• Click Customize on the shortcut menu.

Result: The Customize dialog opens.

1

Click the Peak Table tab.2

• Select the checkboxes in the Filter Peaks field to select the filter criteria.

• Specify filter values.

• Click OK.

3

To filter peaks vs. to reject peaks
The table below describes the major differences in the effects of filtering peaks compared
to excluding the peaks by rejection (which is decribed in Section 5.2.6 Exclude or skim
peaks, on page 128).

Reject peaks...Filter peaks...

permanently excludes peaks from the in-
tegration,

excludes the peaks from display,

excludes the peaks from the calculation
of the total peak area,

does not exclude the peaks from the
calculation of the total peak area,

cannot be reversed.can be reversed.
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Peak labels
Peaks can be labeled with their retention, sequentially numbered, or be marked with
specific identification names. See the following table for an instruction on how to display
peak labels.

The label type can be selected on theCurve Style andColor tab in theCustomize dialog.
Clear all label options to hide the labels, for example for presentations.

The illustration below shows the Customize dialog with the Curve Style and Color tab
opened:

The following table describes how to display peak labels:

ActionStep

• Right-click in the active chromatogram or peak table.

• Click Customize.

Result: The Customize dialog opens.

1
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ActionStep

Click the Curve Style and Color tab.2

Select one or more of the following labeling options in the Peak label field:3

• Number

Result: The peaks will be numbered sequentially.

• Peak Name

Result: Peak names will be displayed. See Section 5.2.4 Edit the integration
parameters, on page112 for information about how to name the peaks.

• Retention

Result: The retention volume or time will be displayed.

Select if the label should be aligned vertically or horizontally in the Text
alignment field.

4

Click OK.5

Measurement options
It is possible to determine the coordinates of any point on a curve and to obtain values
for retention and peak height. This is a useful tool for many other functions, such as for
measuring the parameters used in baseline calculations.

Coordinates can be obtained in two ways:

• Through direct measurement using the Vertical marker. This is described in Sec-
tion 4.1 Open and view results, on page 24.

• From peak table data.
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5.2.4 Edit the integration parameters

Introduction
Once a peak table has been generated based on an appropriate baseline, it is possible
to split or join peaks and to manually adjust the peak start and end points. The peaks
will then be renumbered and the peak values will all be recalculated.

The changes are made in the Edit Peak Table dialog. In this dialog you can also add
peak names that may be used as labels in the chromatogram.

Open the peak table for editing
The following table describes how to open the peak table for editing. The editing options
are described below.

ActionStep

• On the Integrate menu, click Edit Peak Table.

Result: The Edit Peak Table dialog opens.

Note:

If there are several peak tables in the result, the dialog will open for the peak
table tab that is selected. The name of the baseline on which the peak table
was based is displayed in the dialog.

1

Perform the changes (described in the instructions below).2

• Click OK.

Result: The Save Edited Peak Table dialog opens. The dialog displays a
suggested name and location for the peak table.

3

Confirm the name and location and click OK.4

The Edit Peak Table dialog will be opened immediately if you select Save and
Edit Peak Table as the last step of the peak integration.

Note:
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The Edit Peak Table dialog
The illustration below shows the Edit Peak Table dialog:

Toolbar buttons in the Edit Peak
Table dialog

The following table describes the toolbar buttons in the Edit Peak Table dialog.

FunctionButton

Activates the Zoom mode. When it is activated, you can use the mouse
pointer to drag out an area to be zoomed in. This is described in The zoom
function below.

Activates the Edit Peaks mode. In this mode, you can select a peak and
edit the start and end points. This is described in Edit the peaks manually
below.
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FunctionButton

Activates the Set Curve Pointsmode. In this mode, you can select baseline
curve points for editing and add new points to re-draw the baseline. This
is described in Adjust the baseline below.

Activates the Peak Window mode. In this mode you can restrict the part
of the curve that the peak integration is performed on. See Section 5.2.5
Integrate part of a curve, on page 124 for more information.

Returns the result to the state it was in before the last change (Undo).

Note:

This function can also be selected in the Editmenu.

The zoom function
The following table describes how to use the zoom function in the Edit Peak Table dialog.

ActionStep

Click the Zoom button.1

Result: The mouse pointer is changed into .

• Position the mouse pointer over the left topmost position of the area
you want to zoom in on.

• Press and hold the left mouse button.

2

Drag the cursor over the area you want to zoom in on.3

Release the mouse button.4

Result: The area is enlarged.

A Zoomed mode note will be displayed in the top righthand corner of the
chromatogramwhen the zoom function has been used. Right-click, then click
Reset Zoom to return to the full display.

Note:
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Peak start and end points
The beginning of each peak is marked with a dropline above the curve, and the end of
each peak is marked with a dropline below the curve. The illustration below shows an
example of start and end point droplines:

Where there are two adjacent peaks, the end of the first peak will be at the same point
as the beginning of the next peak. Thus, there will be a dropline below and above the
curve at the same point. See the illustration below:

Edit the peaks manually
The start and end points of a peak can be adjusted graphically by moving the droplines
in the Edit Peak Table dialog. The following table describes this:

ActionStep

Click the Edit Peaks button.1

Result: The mouse pointer is changed into .

• Click the peak you want to edit.

Result: The peak is highlighted and marker lines show the start and end
points.

2
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ActionStep

• Position the mouse pointer over the marker line that you want to change.

Result: The pointer is changed into a double-arrow symbol.

3

• Drag the marker to a new position with the mouse pointer.

Result: The start or end point droplines of the peak are changed and the
corresponding values are updated in the peak table.

4

A dropline can never be moved beyond another dropline or beyond a point
where the peak meets the baseline.

Note:

Adjust the baseline
The baseline can be adjusted graphically (see also Section 5.3.1 Edit the baseline manu-
ally, on page 132) in the Edit Peak Table dialog. The following table describes this:

ActionStep

Click the Set Curve Points icon.1

Result: The mouse pointer is changed into .
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ActionStep

Perform one or more of the operations below as desired:2

• Click to insert a new data point.

• Double-click on a data point or right-click the point and select Delete
Point from the shortcut menu to delete the point.

• Click a data point and drag the point to a new position to move the
baseline.

Result: The baseline is edited and the peak table values are recalculated
accordingly.

Accept negative peaksmust be selected before the peak integration if you
want to be able to drag a data point to move the baseline above the curve.

Note:
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Calculate a new baseline
The baseline can be recalculated in the Edit Peak Table dialog. To alter the baseline
settings:

ActionStep

• On the Baseline menu, click New then click Calculate.

Result: The Settings dialog opens.

1

Click an algorithm (Morphological is default).2

• Adjust the Baseline parameters as desired.

- Structure width

- Minimum distance between points

or

• Click Default Values for the default values.

3

• Click OK.

Result: The baseline is recalculated.

4

On the Baselinemenu, click New then click Zero Baseline to replace the cal-
culated baseline with a zero baseline.

Note:

118 UNICORN 7.0 Evaluation Manual 29-1108-88 AA

5 Evaluate results
5.2 Peak integration
5.2.4 Edit the integration parameters



Add color to a peak
The following table describes how to add a fill color and a pattern to an individual peak
in the Edit Peak Table dialog:

ActionStep

Click the Edit Peaks button.1

Result: The mouse pointer is changed into .

Click to select the peak.2

• Right-click and click Fill Peaks from the shortcut menu

or

• on the Edit menu, click Fill Peak.

Result: The Color and Pattern dialog opens.

3

• Select the Fill selected peaks checkbox.

Result: The Color button and Pattern field will become available.

4
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ActionStep

• Click Color.

Result: The Color dialog opens.

5

• Click one of the Basic colors

or

• click Define Custom Colors to open the settings field and define new
colors (illustrated above).

• After you have selected a color, click OK to close the dialog.

6

• Click a fill pattern in the Pattern field.

• Click OK..

Result: The peak is filled according to the selections.

7

The color and pattern selectionswill override the general Fill settings that can
be selected for all peaks on the Peak Table tab in the Customize dialog for
the chromatogram.

Note:
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Split a peak
It is possible to split a peak into two new peaks by inserting a dropline. The following
table describes how to split a peak in the Edit Peak Table dialog:

ActionStep

Click the Edit peaks button.1

Result: The mouse pointer is changed into .

Click the peak in the curve or in the peak table to select the peak.2

• Right-click and click Split Peak

or

• on the Edit menu, click Split Peaks.

Result: A new dropline is inserted at the middle point between the two existing
droplines and the peak is split. The peak numbering and the peak table are
updated accordingly.

3

The area under each new peak will not be the same if the symmetry of the
original peak was not perfect.

Note:

Join peaks
It is possible to join the areas of adjacent peaks if they are separated by a dropline. The
following table describes how to join adjacent peaks in the Edit Peak Table dialog:

ActionStep

Click the Edit peaks button.1

Result: The mouse pointer is changed into .

Click the peak in the curve or in the peak table to select the peak.2

• Right-click and click Join Left or Join Right

or

• on the Edit menu, click Join Left or Join Right.

Result: The original intervening dropline is removed, all peaks are renumbered
and the peak table is updated.

3
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Add peak names
The table below describes how to add names in the Edit Peak Table dialog, to identify
the peaks:

ActionStep

Click the Edit peaks button.1

Result: The mouse pointer is changed into .

Click the peak in the curve or in the peak table to select the peak.2

• Right-click and click Peak Name

or

• on the Edit menu, click Peak name

or

• double-click the peak.

Result: The Edit Peak Name dialog opens. The number and retention of the
selected peak is displayed.

3

Type a name in the Peak name box.4

• Click OK.

Result: The new name is added in the corresponding Peak name cell in the
peak table. It is also shown below the peak in the chromatogram. If you have
selected to show peak names in the chromatogram, it will also be displayed
over the peak.

5

You can also add a peak name by selecting the Peak name cell in the peak
table, click again in the cell and then type the peak name. A pencil symbol is
displayed by the peak number to indicate that you are able to enter the text.

Note:
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Delete peaks
The following table describes how to delete a peak in the Edit Peak Table dialog:

ActionStep

Click the Edit Peaks button.1

Result: The mouse pointer is changed into .

Click the peak in the curve or in the peak table to select the peak.2

• Right-click and click Delete Peaks

or

• on the Edit menu, click Delete Peaks

or

• press the Delete key.

Result: The peak is deleted, the remaining peaks are renumbered and the
peak table is updated.

3

The Integrate menu
If needed, you can click the commands on the Integrate menu to perform a peak inte-
gration in the Edit Peak Table dialog box. This is useful for example if you want to re-in-
tegrate the curve using different settings or integrate only part of a curve with different
settings.

See Section 5.2.5 Integrate part of a curve, on page124 and Section 5.2.6 Exclude or skim
peaks, on page 128 for more information.
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5.2.5 Integrate part of a curve

Introduction
There are several possibilities to improve the results if the peak integration is unsatisfac-
tory. This section describes how to select only part of a curve for integration.

This partial integration can be performed both in the Integrate dialog in preparation for
the peak integration, or in the Edit Peak Table dialog to adjust an unsatisfactory peak
integration. Both alternatives are described here.

Select part of a curve for
integration

The table below describes how to select only a part of a curve for peak integration in
the Integrate dialog box:

ActionStep

• Choose Integrate:Peak Integrate

or

• click the Peak Integrate icon.

Result: The Peak Integrate dialog opens.

1
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ActionStep

• Click the Peak Window... button.

Result: The Set Peak Window dialog opens.

2

• Type new X-axis values for the Left limit and the Right limit.

or

• drag the vertical cursor lines to define the limits.

3

Click OK.4

Result: The baseline will be calculated from the whole curve, but the calcula-
tion of the peak areas is only performed on the selected section.

Edit integration for part of a
curve

Part of a curve can be selected in the Edit Peak Table dialog box and integrated with
settings that differ from the rest of the curve. The table below describes how to do this.

ActionStep

• Choose Integrate:Edit Peak Table.

Result: The Edit Peak Table dialog box opens.

1
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ActionStep

• Click the Reintegration Window icon.

Result: The mouse pointer is changed into and two vertical marker
lines are displayed.

• Place the mouse pointer on one of the marker lines.

Result: The mouse pointer changes shape to a double-sided arrow, see
picture below.

2

Note:

The left marker line may be placed over the Y-axis initially.

Drag the cursor lines to the beginning and the end of the selected part of
the curve.

Note:

All operations described below will only affect the selected part of the curve.

3
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ActionStep

If desired, change the integration parameters:4
Reject peaks

• Choose Integrate:Settings.

Result: The Reject Peaks dialog box opens.

• Change the settings as desired and click OK.

Skim peaks

• Choose Integrate:Peak Skim.

Result: The Peak Skim dialog box opens.

• Select the Skim Peaks checkbox and type a ratio.

• Click OK.

• Choose Integrate:Peak Integrate.

Result: The selected part of the curve is peak integrated based on the
changed parameters.

5

Refer to Section 5.2.6 Exclude or skimpeaks, on page128 for information about
the integration parameters in step 4 above.

Note:
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5.2.6 Exclude or skim peaks

Introduction
The results of the peak integration can sometimes be improved if some peaks are ex-
cluded. Also, more accurate results may be obtained if smaller peaks are skimmed off
larger peaks with shoulders, as described in this section.

Exclude peaks
The table below describes how to define peaks to be excluded in the Peak Integrate di-
alog during a peak integration.

ActionStep

Click the Reject peaks button.1

Result: The Reject Peaks dialog opens.

• Select the appropriate checkboxes and type values for peak height, width
and area.

• Define how many of the largest peaks you want to include.

2

Click OK.3

Proceed with the peak integration.4

You can also exclude peaks from the peak integration in the Edit Peak Table
dialog. Select Integrate:Settings to open the Reject Peaks dialog.

Note:
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Include negative peaks
Select the Accept negative peaks checkbox of the Peak Integrate dialog to include
negative peaks in the integration. The negative peaks will be reported as negative areas
in the peak table. By default, negative peaks are not included in the integration.

Peak skimming vs. droplines
The area under a peak can be calculated either using separating droplines or peak
skimming:

• Droplines are vertical marks that split two peaks at the valley. Droplines are used
mostly for peaks of relatively similar size. When a peak has a shoulder, splitting with
droplines will cause the first peak to lose too much of its area to the peak that forms
its shoulder.

• The Peak skim option can be used to skim off the smaller peak with a straight line
that starts in the valley between the peaks and ends at the other side of the smaller
peak, at the point where the skim line and the curve slope are equal.

The illustration below is an example of how a dropline (left) and a skimmed peak (right)
affect the area under the main peak and the peak shoulder. The peak shoulder area is
marked in gray:
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Skim peaks
The table below describes how to select a ratio to skim peaks in thePeak Integratedialog:

ActionStep

Select the Peak skim checkbox.1

Determine the ratio when peak skimming should be applied based on the
relationship in the illustration below:

2

Note:

The default ratio value is 10.

Type the ratio value in the text box.3

Proceed with the peak integration.4

You can set a peak skim ratio or edit earlier settings after the peak integration.
Open the Edit Peak Table dialog and select Integrate:Peak Skim.... and enter
a Ratio in the Peak Skim dialog.

Note:
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5.3 Baseline operations

About this section
In order to achieve the best possible peak integration result, the baseline may have to
be edited or optimized. This section describes:

• how to edit the baseline manually

and

• how to optimize the baseline using a selected algorithm.

In this section
This section contains these subsections:

See pageSection

1325.3.1 Edit the baseline manually

1365.3.2 Optimize the baseline with a morphological algorithm

1405.3.3 Optimize the baseline with a classic algorithm
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5.3.1 Edit the baseline manually

Introduction
The first choice when you want to optimize the peak integration is to change the baseline
parameters. This section describes how to optimize the baseline manually.

The Edit Baseline dialog
You can edit the baseline manually in the Edit Baseline dialog in the Evaluation Classic
module:

• Click Integrate:Edit Baseline to display the dialog.

The Edit Baseline dialog displays the baseline and the curve it was calculated from. The
baseline points are marked with gray squares. A selected baseline point is colored red.
Hold the cursor above the baseline point to display its coordinates to the left, below the
chromatogram. See the illustration below:
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How to use the zoom function
The table below describes how to use the zoom function in the Edit Baseline dialog.

ActionStep

• Click the Zoom icon.

Result: The cursor is changed into a magnifying glass.

1

• Press and hold the left mouse button.

• Drag the cursor over the area you want to zoom in on.

• Release the mouse button.

Result: The area is enlarged. Right-click and select Reset zoom to restore
the full view.

2

How to edit and insert data
points

The tables below describe how to edit and insert baseline data points:

ActionStep

Select Integrate:Edit Baseline.1

Result: If there is more than one baseline available, the Select Baseline to
Edit dialog opens. If not, proceed to step 2.

• Select the baseline you want to edit from the list.

• Click OK.

Result: The Edit Baseline dialog opens

• Click the Set Curve Points icon.

Result: The mouse pointer is changed into a pen symbol and a cross.

2

Add, delete and/or move data points according to the table below.3

UNICORN 7.0 Evaluation Manual 29-1108-88 AA 133

5 Evaluate results
5.3 Baseline operations

5.3.1 Edit the baseline manually



ActionStep

Click OK.6

Result: The Save Edited Baseline dialog opens.

• Confirm the location and type a new name if necessary.

• Click OK.

Result: The new baseline is saved.

7

Then...If you want to...

Click the left mouse button to place a new baseline point
in the chromatogram.

Add a data point

Result: A new point is created, marked by a red square.
The baseline curve is redrawn as a smooth spline function
based on the old and the new points. The baseline is
guided by the points, but does not necessarily pass
through them.

Tip:

If youwant to create straight baselines, read the instruction
later in this section.

Click the data point to select it and click theDelete button.Delete a data point

Result: The data point is deleted and the curve is redrawn.

Note:

Click the Delete All button to delete all the data points at
once.

Select the data point and drag it to a new position.Move a data point

Result: The baseline curve is redrawn.

Click the Undo button to cancel the last edit if the result is not satisfactory.Tip:
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Edited baseline
The illustration below is a simulated example of a baseline before and after editing:

How to draw a straight line
The table below describes how to force a straight baseline between two points.

ActionStep

Select the first of the two points in the point list.1

Click the Draw straight to next point button.2

Result: The baseline is drawn through the points as a straight line.
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5.3.2 Optimize the baseline with a morphological algorithm

Introduction
The first choice when you want to optimize the peak integration is to change the baseline
parameters. This section describes how to optimize the baseline with a morphological
algorithm.

Morphological algorithm
description

A morphological algorithm can be described as a line that follows the chromatogram
parallel to the X-axis. Data points for the baseline are created whenever the line touches
the curve, and the points are joined at the end to create a baseline.

A morphological algorithm gives the best result in curves with drifting baseline and peak
clusters. The morphological baseline follows the curve faithfully, and a curve with a
baseline at a more even level can be created by subtracting the morphological baseline.

A morphological algorithm does not work well if there are negative peaks or if quantitative
data from negative peaks are important in the run.

Morphological algorithm is the default baseline setting.Note:

How to set a morphological
baseline

Follow the instructions to choose aMorphologicalalgorithm and define baseline settings.

ActionStep

Click the button or select Integrate:Edit Peak Table to perform peak
integration.

1

• Choose Calculate baseline in the Baseline drop-down menu.

• Click the Baseline settings button.

Result: The Baseline Settings dialog opens.

2
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ActionStep

• Select the Morphological algorithm.

• Change the Baseline parameters if necessary.

See more information about the parameters below this table.

3

• Click OK.

Morphological algorithm
parameters

The parameters for the Morphological algorithm are:

• Structure width

• Minimum distance between points

Structure width
Structurewidthdetermines the length of the straight line that follows the chromatogram.
The default value is set at the widest peak in the chromatogram multiplied by 1.5.

The illustration below is an example of how a morphological baseline follows the peaks
at the different levels in the curve:
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The correct structure width
settings

Settings too low
Structure width settings that are too low can result in a baseline that reaches too high
up in the peaks of the curve. Sometimes a wider peak is not recognized because it con-
tains a cluster of smaller peaks. The Structure width is then set to a value according to
the largest width of the identified narrower peaks, and must be increased.

Settings too high
Structure width settings that are too high mean that narrower peaks, especially in
fluctuating curves, are not properly followed. This happens when an artifact in a curve
is identified as the widest peak by the morphological algorithm, and then is used to set
the default Structure width value.

The illustration below is an example of baselines using the default morphological algo-
rithm settings (A) and a morphological algorithm with an increased Structure width
value (B).
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Minimum distance between
points

The Minimum distance between points is a measure of the distance between the data
points used to generate a baseline. The largest number of data points is produced at
the slopes of the curves. If you increase the Minimum distance between points value,
fewer points will be collected on the slopes.

The illustration below is an example of a baseline (A) that is created with the Minimum
distance between points parameter set at a low value. The number of data points is
reduced when theMinimumdistancebetweenpointsparameter is set to a higher value
(B).
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5.3.3 Optimize the baseline with a classic algorithm

Introduction
The first choice when you want to optimize the peak integration is to change the baseline
parameters. This section describes how to optimize the baseline with a classic algorithm.

Classic algorithm description
A classic algorithm searches for all parts of the source curve that are longer than a de-
fined minimum baseline segment and fall within limiting parameters. Together, the pa-
rameter values define the limits for a rectangular box. A part of the source curve must
fit entirely inside this rectangular box to be identified as a baseline segment.

A classic algorithm is particularly useful when you need to integrate curves with negative
peaks and when quantitative data from negative peaks are important.

Classic algorithm parameters
The parameters for the Classic algorithm are:

• Shortest baseline segment

• Noise window

• Max baseline level

• Slope limit

See more information about the parameters below.

How to set a classic baseline
Follow the instructions below to set a Classic algorithm and define a baseline.

ActionStep

Click the Baseline settings button in the Peak Integrate dialog.1

Result: The Baseline Settings dialog opens.
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ActionStep

• Select the Classic algorithm.

• Change the Baseline parameters.

See more information about the parameters below this table.

• Click OK.

2

The same settings can be edited in theCalculate Baseline dialogwhen a new
baseline is created. Choose Integrate:Calculate Baseline to open the dialog.

Tip:

Test your parameter changes
The best way to optimize the baseline is to change the baseline parameters step by step
and then check the resulting baseline after each change. When the desired effect is ac-
complished it is best to go back and try a parameter value in between the two last settings
to avoid an unnecessarily low or high value.

How much the values should be changed depends on the cause of the peak integration
problem. The table below is a general guideline.

Recommended initial changeBaseline parameter

20%-50%Shortest baseline segment

10%-30%Noise window

Usually not necessary to adjustMax baseline level

25%-50%Slope limit

If necessary, click the Default Values button to restore the default values.Tip:
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Shortest baseline segment
If an excessively high Shortest baseline segment value is set, short curve segments
between peaks in the middle of the chromatogram are not identified as baseline seg-
ments. The calculated baseline does not follow the source curve, see below:

The Shortest baseline segment value is decreased by 50% in this example:
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Slope limit
A changed Slope limit will often improve the baseline calculation. The Slope limit sets
the maximum slope of the curve to define when a peak is recognized. An excessively
high Slope limit will cause the up-slopes of the peaks to be recognized as baseline seg-
ments.

The example above was improved by the shorter baseline segments but the high slope
of the short segments in the region between the second and the fourth peak still makes
the baseline unacceptable. In the example below the Slope limit is increased by a factor
of 2.5, which produces a correct baseline:

Slope limit too high
An excessively high Slope limit value can cause peak limits too high up on the peaks.
This can be the case when the chromatogram includes a very large flowthrough or solvent
peak. The large peak affects the calculation of the default parameters and leads to ex-
cessively high values for the Slope limit.

An excessive value for the Noise window can have the same effect and be
caused by the same situation, often also in combination with a high Slope
limit.

Note:

Peak limits are defined on peaks in the example below due to the high Slope limit:
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The example below has a much lower Slope limit, and a lower Noise window:
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Noise window
Occasionally too many peaks occur after the peak integration, usually because noise
on the baseline is erroneously detected as peaks. The solution to this is to increase the
Noisewindow parameter. However, this can result in peak limits too high up on the peak
slopes. The illustration below is an example of noise detected as peaks (A) and the result
of a second peak integration with an increased Noise window (B).

You can also use the Reject peaks function in the Peak Integrate dialog to
reduce the number of peaks based on the total number of accepted peaks or
the minimum peak height.

Tip:
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Missing peaks
Sometimes obvious peaks are not detected in the peak integration. The probable cause
is that the Noise window is set too high. See the illustration below:

All peaks are detected if the Noise window is decreased- see example below:

Missing peaks can also be caused by improper settings for Reject peaks in
thePeak Integratedialog, or Filter peaks in theChromatogramLayoutdialog.

Note:
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When to change the Max
baseline level

In rare cases the top of a broad, flat peak can be incorporated as a baseline segment.
This is one of the very few situations where it is useful to change the Max baseline level.
The illustration below is an example:

How to set theMaxbaseline level
Follow the instructions below to set the Max baseline level.

ActionStep

Right-click in the chromatogram and select Marker.1

Result: A vertical line is set in the chromatogram. A text box in the top left
corner of the chromatogram displays the X-axis and Y-axis values of the
curve at the point where the vertical Marker line crosses the curve.

• Move the Marker with your mouse.

• Measure the height of the peak you want to exclude from the baseline.

2

Choose Integrate:Calculate baseline.3
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ActionStep

• Select Classic as Algorithm.

• Type a new value forMax baseline level. Set the level slightly lower than
the value that you measured in step 2.

• Click OK.

4

Example of a correct baseline
The illustration below is an example of a correct baseline after the Max baseline level
has been changed:
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5.4 Fraction and peak operations

About this section
This section describes other operations that you can perform on your results, including:

• Pool several fractions into combined fractions,

• create an average fraction absorbance curve, the Fraction Histogram,

• match protein activity to a curve using the Activity Histogram

and

• use the absorbance ratio to verify peak purity or identify peaks.

In this section
This section contains these subsections:

See pageSection

1505.4.1 Pool fractions

1535.4.2 The Fraction Histogram

1565.4.3 Match protein activity to a curve

1585.4.4 Peak purity and peak identification
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5.4.1 Pool fractions

Introduction
Fractions are collected sequentially during a separation. Each fraction contains a set
volume of sample. This section describes how to pool the curves from several fractions
into a new curve.

Display the fractions in the
chromatogram

Each fraction is numbered according to its order in the sequence. The information is
saved as a curve under the name Fractions.

To display the position of each fraction in relation to the information displayed on the
UV detection curve:

• Select the Fraction... curve on the Curve tab in the Customize dialog.

or

• Right-click in the chromatogram and select the Filter Curvesmenu command. Select
the checkbox for the Fraction... curve.
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Pool fraction curves
The table below describes how to pool fractions.

ActionStep

• Open the result from the File Navigator.

• Choose Operations:Pool Fractions.

Result: The Pool Fractions dialog opens:

1

The fraction curves for the selected chromatogram are listed in the Fraction
marks field. The fractions for the selected fraction curve are shown in the
Fraction no. field.

• Select the check box for each fraction to be pooled.

Note:

Only adjacent fractions will be pooled. In the example above, fraction
3.A.1 will be pooled with fraction 3.A.2 and fraction 3.B.2 will be pooled
with fraction 3.B.1.

• Select the destination for the new curve in the Target chromatogram
and curve field.

• Click OK.

Result: The fraction curve with the pooled fractions is added to the chro-
matogram.

2

The default name for the fraction curve is shown in the Curve name field. The
default curve ending is POOL. The default curve name can be changed as
needed by typing a new name in the field before the fractions are pooled.

Tip:
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Show only the pooled fraction
curves

The active chromatogram will now show both the original and the pooled fraction curves.
The table below describes how to show only the pooled fractions.

ActionStep

• Right-click in the chromatogram and select the Customize dialog. Click
the Curve tab.

or

• Right-click in the chromatogram and select the Filter Curves menu
command. Select the checkbox for the Fraction... curve.

1

• De-select the check box for the original fraction curve (remove the check
mark).

Result: The original fraction curve is de-selected and is not displayed.

2

152 UNICORN 7.0 Evaluation Manual 29-1108-88 AA

5 Evaluate results
5.4 Fraction and peak operations
5.4.1 Pool fractions



5.4.2 The Fraction Histogram

Introduction
The Fraction Histogram dialog in the Evaluation Classic module can be used to create
a curve for the average fraction absorbance. It can also be used to create a table
showing the amount of protein and the concentration in each fraction.

Create a Fraction Histogram
curve

Follow the instructions below to create a Fraction Histogram curve.

ActionStep

Select Operations:Fraction Histogram.1

Result: The Fraction Histogram dialog opens.

Select the desired UV curve in the left Source chromatogram and curve
field.

Tip:

The fractions curve should already be selected on the middle field.

2

Click OK.3

Result: The average fraction absorbance values are displayed as a new curve
in the chromatogram.

By default, the FractionHistogram curvewill be assigned to the first available
curve position, which is shown in the Target chromatogram and curve list.
A default curve name with the ending HIST is suggested in the Curve name
field. You can choose another curve position and type another curve name in
the Curve name field if desired.

Tip:

Protein concentrations in the
fractions

The protein concentration in the fractions are calculated using the following formula:

Concentration [mg/ml] = A / (d * 1000 * Ext. coef.)

A = Average fraction absorbance = Area / Volume [mAU]

d = UV cell path length [cm]

Ext. coef. = Protein coefficient at used wavelength. [l g-1 cm-1]
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Protein amounts in the fractions
The total amount of protein found in the fraction is calculated using the following formula:

Amount [mg] = Concentration [mg/ml] * fraction volume [ml]

Calculate the protein
concentration and amount

Follow the instructions below to calculate the protein concentration and amount in the
fractions using the Fraction table in the Fraction Histogram dialog:

ActionStep

Select Operations:Fraction Histogram.1

Result: The Fraction Histogram dialog opens.

Note:

If the path length is not shown, it can be entered manually.

Type the extinction coefficient for each fraction in the corresponding Ext.
coef table cell.

2

Result: The fraction protein concentration and amount are calculated and
displayed in the corresponding Conc. and Amount table cells.

Note:

The values are calculated using a zero baseline (i.e., no baseline subtraction
is applied).

Export the Fraction table
The complete Fraction table can be exported as an Excel file:

ActionStep

Click the Export Table button in the Fraction Histogram dialog.1

Result: The Export Fraction Table to Excel file dialog opens.

Browse to the folder where you want to save the file.2

Type a name in the File name field.3

Click the Save button.4

Result: The table is saved in Excel format.
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Print the Fraction table
The complete Fraction table can be printed directly from the FractionHistogram dialog:

ActionStep

Click the Print Table button.1

Result: The Print dialog opens.

If necessary, select a printer and the number of copies to print. You may also
click the Properties button in this dialog, to change the general printer set-
tings.

2

Click OK.3

Result: The table is printed on the selected printer.
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5.4.3 Match protein activity to a curve

Introduction
You can compare data from the results of protein activity assays, such as ELISA, with
the data contained in the UV curve. The activity curve and the UV curve can be compared
in a combined presentation.

The Activity Histogram dialog
The illustration below shows the Activity Histogram dialog:
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Enter protein activity values for
comparison

Follow the instructions below to enter the values from a protein activity assay in a
comparison histogram:

ActionStep

Choose Operations:Activity Histogram.1

Result: The Activity Histogram dialog opens.

By default, the fraction curve for the current chromatogram is selected in
the Source chromatogram and fraction curve list.

2

• If necessary, change the source and target chromatograms.

All the component fractions of the fraction curve are listed in the Fraction
column of the Edit source activity values field.

• Type an activity value for each fraction in the Activity column.

• Click OK.

Result: A histogram curve showing the activity values is added to the chro-
matogram.

3

By default, the Activity Histogram curvewill be assigned to the first available
curve position, which is shown in the Target chromatogram and curve list.
A default curve name with the ending HIST is suggested in the Curve name
field. You can choose another curve position and type another curve name in
the Curve name field if you so wish.

Tip:
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5.4.4 Peak purity and peak identification

Introduction
Ratios between UV curves measured at different wavelengths give useful information
about peak purity or peak identity.

Peak purity
The absorbance ratio can be used to check peak purity. If the peak is pure, the absorbance
spectra are the same over the whole peak and the ratios should therefore remain con-
stant. The peak is probably not pure if the absorbance ratio is not the same over the
whole peak.

The illustration below shows a chromatogram of two co-eluting components with differing
absorbance spectra and a small difference in retention time:

Peak identification
The absorbance ratio can be used for peak identification. Different compounds have a
specific ratio between absorbancies at different wavelengths.

The illustration below shows a chromatogram of two components with differences in
their absorbance spectra:
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Divide the curves
Both curves must have a baseline close to zero AU before they can be divided. This is
achieved with baseline subtraction. The table below describes how to subtract the
baseline from an earlier integration and divide the curves:

ActionStep

Perform peak integrations to create a baseline for each UV curve, see Perform
a peak integration.

1

Select Operations:Subtract.2

Result: The Subtract dialog opens.

• Select the UV curve in the first Source chromatogram and curve list.

• Select its baseline in the second Source chromatogram and curve list.

• Click OK.

Result: A curve with the subtracted baseline is added to the chromatogram
in the first available curve position. By default, the curve name will have a
SUB ending.

Tip:

You can also subtract corresponding blank runs if there are blank runs avail-
able.

3

Repeat steps 2 and 3 for the second UV curve.4

Select Operations:Divide.5

Result: The Divide dialog box opens.
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ActionStep

• Select the first result curve from the subtractions in the first Source
chromatogram and curve list.

• Select the second result curve from the subtractions in the second Source
chromatogram and curve list.

6

Click the checkbox for Threshold and type values for each curve. This results
in the following:

7

• The quotient is set to 1.0 if either of the sample values is closer to zero
than the threshold value. Very high quotient values are prevented if divi-
sion is performed with values close to zero. Very low quotient values are
also prevented.

Note:

DefaultThreshold values are entered byUNICORN. The values canbe changed.

Click OK.8

Result: A new curve is added to the chromatogram in the first available po-
sition. By default, the curve name will have a DIV ending.

Filter the result curve
The resulting curve can be filtered to reduce noise and to remove ghost peaks. The table
below describes how to filter the curve.

ActionStep

Select Operations:Smooth.1

Result: The Smooth dialog opens.

• Select the Source Chromatogram.

• Select a Filter Type.

Tip:

TheMedian filter is recommended to remove noise that appears as spikes or
occurs in a small area of the curve.

2

• Click OK.

Result: A new curve is added to the chromatogram in the first available po-
sition. By default, the curve name will have a SMTH ending.
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5.5 Compare different runs

About this section
This section describes

• how to make comparisons between curves or chromatograms from different runs

• how to present curves or chromatograms from different runs

• how to compare curve parameters among curves from different runs

• how to view several chromatograms at the same time

• how to overlay curves from different runs in one chromatogram

• how to stack curves from different runs in one chromatogram

• how to create mirror images

In this section
This section contains these subsections:

See pageSection

1625.5.1 Open and compare chromatograms

1695.5.2 Open and compare curves

1785.5.3 Shift curves

1795.5.4 Create a mirror image
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5.5.1 Open and compare chromatograms

Introduction
This section describes

• how to import chromatograms from other result files to an open result,

and

• how to compare chromatograms in a result.

Commands to use
Two commands in the Evaluation Classic module can be used to import chromatograms
from results into an open result:

• File:Open to compare

This is the preferred option when you search for many chromatograms in a specific
folder based on defined selection criteria. See “How to import chromatograms with
the command File:Open to compare” below.

• File:Open

This is the preferred option to import any individual chromatograms from result files
indifferent folders. See “How to import chromatograms with the command File:Open”
below.

Open chromatograms
You can display several chromatograms, from different results, simultaneously for
comparison. The table below describes how:

ActionStep

Open the result containing the first chromatogram.1
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ActionStep

• Choose the File:Open menu

• Choose the Chromatogram menu item

Result: The Open Chromatograms dialog opens.

2

Select a result in the browser pane.3

Result: The chromatograms in the result are listed in the Available list.
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ActionStep

• Click the checkbox for each chromatogram in the Available list that you
want to select.

• Click the selection button (as illustrated above).

Result: The chromatogram is added to the Selected list.

Tip:

You can click the de-selection button to remove selected chromatograms
from the list. This will remove all chromatogramswith checkmarks. Note that
you must first click to remove the checkmark from each chromatogram that
you want to keep in the Selected list.

4

• Repeat step 4 until you have selected all the chromatograms you want
to open.

• Click the OK button.

Result: The selected chromatograms open in the Evaluation Classic module.

Note:

If the names of the imported chromatograms already are used they will be
sequentially numbered for identification purposes. Each chromatogram will
be opened in its own tab. However, depending on the number of chro-
matograms and the length of the names, not all tabs may be visible at once.
Click the arrow symbol on the top right corner of the chromatogram pane to
show a list of all open chromatograms. You may select the chromatogram
you want to view from this list.

5
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Import chromatogramswith the
command File:Open to compare

The table below describes how to import chromatograms with the File:Open to compare
command. The search is performed at specific locations or with specific search criteria.
This method is useful if, for example, you want to import chromatograms from all results
of a scouting folder.

ActionStep

Choose File:Open to compare:Chromatograms in the Evaluation Classic
module.

1

Result: The Open Chromatogram to Compare dialog box is displayed.

• Click the Browse button beside the Folder droplist

This opens a browse dialog where you can select the result folder where
you want to search for chromatograms.

Note:

The search will not include the contents of subfolders. You must select
the subfolders individually for the search.

• Repeat this step to define specific results or chromatograms if desired.

Tip:

Click the droplist arrow buttons to view searchpaths that you have used
previously. You can click selections in these lists to search the same locations
again.

2
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ActionStep

• Click the Search button in the Found chromatograms field and a list of
chromatograms will be displayed based on the designated search criteria.

• A new search can be performed with new search criteria without erasing
the initial chromatograms from the list.

• Select the chromatograms that you want to import. If you click the Select
All button, all the displayed chromatograms will be imported.

• If you want to clear the list of displayed chromatograms, click the Clear
button.

3

• Click OK.

Result: All the selected chromatograms are opened in the Evaluation Classic
module.

Note:

If the names of the imported chromatograms are already used they will be
sequentially numbered for identification purposes. Each chromatogram will
be opened in its own tab. However, depending on the number of chro-
matograms and the length of the names, not all tabs may be visible at once.
Click the arrow symbol on the top right corner of the chromatogram pane to
show a list of all open chromatograms. You may select the chromatogram
you want to view from this list.

4
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Display and compare the
imported chromatograms

By default, the chromatograms are opened behind each other in the full chromatogram
pane. The table below describes how to arrange the imported chromatograms so that
several can be viewed and compared at the same time:

Arrange the chromatograms

ActionStep

Click the tab of one of the chromatograms and hold the mouse button
pressed.

1

Result: A positioning icon is displayed in the chromatogram pane.

Move the mouse pointer to the area of the window where you want to place
the pane.

2

The arrows of the symbol show the side of the pane where the selected
chromatogram will be docked. Drag the mouse pointer over the appropriate
arrow.

3

Result: The area where the chromatogram will be docked is colored.

Release the mouse button.4

Result: The pane is moved and docked in the new position.

Tip:

Several chromatograms may share a space, either placed on top of each
other or arranged side by side or above each other. Click the center position
of the symbol to place a chromatogram on top of another.

Tip: • To restore the original layout with the chromatograms displayed as tabs,
select View:Chromatograms as Tabs.

• To view all chromatograms side by side, select View:Tile All
Chromatograms.

UNICORN 7.0 Evaluation Manual 29-1108-88 AA 167

5 Evaluate results
5.5 Compare different runs

5.5.1 Open and compare chromatograms



Display all chromatograms on the same scale

ActionStep

Click the Customize icon or select Tools:Customize to open the Customize
dialog for any chromatogram.

1

Select the X-Axis tab and make the changes to the Base and the Axis scale.2

Select the Apply to all chromatograms option and click OK.3

Imported chromatograms cannot be shown with column volume as the X-
axis base.

Note:
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5.5.2 Open and compare curves

Introduction
This section describes how to import or copy curves from different runs into one chro-
matogram for comparison.

Commands to use
Two commands can be used to import curves from results into one chromatogram:

• File:Open to compare

This is the preferred option if you want to automatically search result files that are
stored in the same folder to locate all curves of a specified type, for example, all UV
curves. This is especially useful for comparison of curves from scouting runs. More-
over, the imported curves can be automatically overlaid, stacked or presented as
mirror images. See "File:Open to compare" below.

• File:Open:Curves

This is the preferred option to import individual curves. See "File:Open:Curves" below.

Original curves are underlined in the chromatogram, imported and created
curves are not underlined.

Note:
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File:Open to Compare
The table below describes how to import curves to a chromatogram with the command
File:Open to Compare:

ActionStep

In the Evaluation Classic module,1

• choose File:Open to compare:Curves

or

• click the Open curves to compare toolbar button.

Result: The Open Curves to Compare dialog opens.
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ActionStep

• Select the desired search criteria in the Folder, Result, Chromatogram
and Curve droplists of the Curve selection section.

• Click Search and a list of curves will be displayed based on the selected
search criteria.

Tip:

A new search can be performed with new search criteria without erasing
curves located in the previous search.

2

• Select the check boxes for the curves that you want to import. Click the
Select All button if you want to import all the curves.

• If you select the Store in new chromatogram option, the curves will be
imported into a new chromatogram. This is recommended to keep the
source chromatogram free of too many additional curves.

• Select how to display the imported curves in theCurve options field. The
options are described in "Curve options" below.

• Click OK.

3
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ActionStep

If you selected the Stack option in step 3, the Shift Curves by Offset dialog
is displayed:

4

• You can set the Offset value to increase or decrease the offset distance
between the curves.

• Click OK.

Result: Depending on your previous choices, the imported curves are now
displayed in the source chromatogram or in a newly created chromatogram.

Note:

If curves with several different units have been selected, the curves with each
different unit will be grouped together with separate offset from the other
groups.
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Curve options
The illustrations below show the different curve presentation options:

Overlay

The curves are presented overlaid on one another.

Stack

The curves are presented with a given offset Y-axis value so that the curves are stacked
and distinct from one another.
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Mirror

For comparison of two imported curves. One curve is inverted in the Y-axis and thus
appears to mirror the other curve. See Section 5.5.4 Create a mirror image, on page179.

Change comparison settings
The table below describes how to change other comparison settings:

ActionStep

Click the Customize icon to open the Customize dialog.1

Select or de-select the check boxes on the Curve tab to compare a different
set of curves.

2

• Select the Y-Axis tab to change the curve scales either

- individually

or

- all with the same scale (click the All With This Unit button).

• Click OK to update the curves.

3
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ActionStep

• If you stacked the curves and want to change the stack offset

- choose Operations:Shift offset

and

- type a new Offset value.

• Click OK to close the dialog and update the curves.

Note:

Curves with a fixed Y-axis scale can not be shifted. Scale for curve number
in the Y-Axis tab of the Customize dialog must be set to Auto for the curves
to be shifted.

4

Tip:

The individual curves can also be moved (see Section 5.5.3 Shift curves, on
page 178).

File:Open:Curves
The table below describes how to import individual curves into an active chromatogram
with the File:Open:Curves command:

ActionStep

Make sure that the destination chromatogram for the imported curve(s) is
active on the screen.

1

• Select File:Open:Curves in the Evaluation Classic module.

Result: The Open Curves dialog is displayed.

• Select the folder and the result file in the browse field of the dialog.

• Select a chromatogram on the Available curves droplist. Usually there
is just one chromatogram.

Result: The available curves are listed below.

2

• Click the checkboxes on the list for the curves that you want to import
and click the select (right arrow) button.

Result: The selected curve(s) is displayed in the Selected curves list.

Tip:

To remove a curve from the Selected curves list, ensure that the corresponding
checkbox is selected and that the checkboxes for all other curves are unse-
lected, and then click the de-select (left arrow) button.

UNICORN 7.0 Evaluation Manual 29-1108-88 AA 175

5 Evaluate results
5.5 Compare different runs

5.5.2 Open and compare curves



ActionStep

• Repeat step 2 if you want to import curves from other chromatograms.

• Click OK when you have selected the curves you want.

Result: The selected curves are added to the active chromatogram.

3

Copy curves into a new
chromatogram

A practical way to compare curves is to create a chromatogram and copy curves from
different chromatograms into the new chromatogram. The comparisons are then per-
formed in the new chromatogram.

The table below describes how to copy curves into a chromatogram:

ActionStep

• Choose File:New:Chromatogram.

Result: The New Chromatogram dialog is displayed.

• Type in a name for the chromatogram.

• Set a volume unit for the chromatogram.

• Click OK to add the empty chromatogram to the current result.

1

Open the source chromatogram(s)

ChooseFile:Open:Chromatogram to open the chromatogram(s) that contains
the curves you want to copy.

Result: The Open Chromatogram dialog opens.

2

• Select the result file.

• Click the check box for the source chromatogram in the Available list.

• Click the select (right arrow) button.

• Click OK.

Result: The source chromatogram opens.

3

Copy the curves

• Choose Edit:Copy Between Chromatograms:Curves.

Result: The Copy Curve dialog is displayed.

4
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ActionStep

• Select the source chromatogram and a curve of interest in the Source
Chromatogram field.

• Select the new chromatogram and a curve position in the Target
Chromatogram field.

A default curve name with the ending COPY is suggested in the Curve
name field.

• Click the Copy button.

• Repeat this step for as many curves as you want, from the same or
other chromatograms.

Tip:

You can open more source chromatograms with the
File:Open:Chromatogram command.

• Click the Close button when you have copied all curves.

5

Alternative way to copy curves
An alternative way to copy curves into one chromatogram is to

• create a new chromatogram by copying an existing chromatogram and saving it
under a new name

• import more curves into the new chromatogram according to the instructions de-
scribed above in this section.
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5.5.3 Shift curves

Introduction
You can use the Shift function to stack and move curves from different runs to better
visualize the differences. Each curve is repositioned along the X- or Y-axis by a precise
value and the instruction is logged in the evaluation log.

The Shift function requires the curves to be present in one chromatogram.Note:

Move a curve with the Shift
function

The table below describes how to use the Shift function:

ActionStep

• Make sure that a chromatogram with the relevant curves is open in the
Evaluation Classic module.

• Choose Operations:Shift.

Result: The Shift dialog is displayed.

1

• Select the curve to be shifted in the Source chromatogram and curve
list.

• Select a curve position in the Target chromatogram and curve list.

• Type a new Curve name or accept the default. The default curve name
ending is SHFT.

2

• Select the axis/axes along which the shift is to be made:

- along the X-axis (Shift retention)

- along the Y-axis (Shift amplitude).

• Type the shift value(s).

• Click OK.

3

Repeat steps 1 to 3 to shift other curves in the chromatogram.4
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5.5.4 Create a mirror image

Instruction
A very useful way to compare the features of two curves is to produce a mirror image
of one curve. The table below describes how to do this:

ActionStep

• Open a chromatogram to insert the relevant curves into.

• Choose File:Open to Compare:Curves.

Result: The Open Curves to Compare dialog is displayed.

1

• Select the desired search criteria in the Folder, Result, Chromatogram
and Curve droplists of the Curve selection section.

• Click Search and a list of found curves will be displayed based on the
selected search criteria.

Tip:

A new search can be performed with new search criteria without erasing
curves located in the previous search.

2

• Select the checkboxes for the curves that you want to import.

• Select Mirror in the Curve options field.

• Click OK.

Result: The curves are displayed with one of the curves as a mirror image
in the active chromatogram window.

3
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ActionStep

Shift the mirror image curve downwards

Shift the mirror image curve downwards for an improved presentation:

• Choose Operations:Shift.

Result: The Shift dialog box is displayed.

• Select the curve to be shifted in the Source chromatogram and curve
list.

• Select the same curve number in the Target chromatogram and curve
list box as in step 2.

• Select the Shift amplitude checkbox since the shift is to be made along
the Y-axis.

• Type a shift value.

• Click OK.

The illustration below shows a curve and a mirror image curve displayed.

4
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5.6 Multi Result Peak Compare wizard

Introduction
This section describes how to use the Multi Result Peak Compare wizard to make sta-
tistical comparisons between peaks in different results, for example by comparing area,
retention, etc. The calculated statistics are presented in a spreadsheet.

Before you proceedwith thewizard comparison, all resultsmust be peak inte-
grated using the same retention unit.

Note:

Wizard workflow
The pages of the wizard are described in the table below:

DescriptionPage

Welcome page.Entry dialog

Select the retention unit that was used previously during
peak integration.

Retention unit selection

Select the curves for comparison.Data selection

Identify the peaks for comparison in all selected curves.Peak selection

• Select peaks in the first curve

• The system identifies the corresponding peaks in all
other selected curves.

Select peak characteristics to be included in the compari-
son result.

Peak data selection

View the results of the comparison.Data view
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Step 1: Select the retention unit
The table below describes how to select the retention unit:

ActionStep

In the Evaluation Classic module,1

• choose File:Multi Result Peak Compare

or

• click the Multi Result Peak Compare toolbar icon

Result: The Multi Result Peak Compare wizard entry dialog is displayed.

Tip:

At this point you may choose to use stored wizard settings. This is described
in "Open the stored wizard settings" below.

Click the Next button to display the Retention Unit Selection dialog.2

Select the retention unit that was used when the compared results were
integrated:

3

• min

• l

• ml

• μl

• nl

Click the Next button to proceed to the Data Selection dialog.
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The Data Selection dialog
The illustration below shows the Data Selection dialog.

Step 2: Select curves to compare
The table below describes how to select curves to compare:

ActionStep

Use the droplists and Browse buttons in the Curve selection field to specify
the result files, chromatograms and curves for comparison.

Tip:

Click the All button if you want to select all available results, chromatograms
or curves.

1

Click the Search button in the Found curves field.2

Result: A list of all curves that matched the search criteria is displayed in the
Found curves field.
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ActionStep

• Select the checkboxes (or click the Select All button) of the desired curves
within the Found curves field.

• Click the Next button to proceed to the Peak Selection dialog.

Note:

If any of the results was not peak integrated before, or if different retention
units were used, youwill be asked if youwish to proceed only with the results
that were integrated with the selected retention unit, or if you want to cancel
the wizard.

3

The Peak Selection dialog
The illustration below displays the Peak Selection dialog:

Dialog description
The dialog displays the following properties for the first of the chosen curves:

• The integrated peaks and the associated peak table in Peak data.

• The Peak Identification Settings table. Its purpose is to identify the peak parameter
to be used for peak identification in the results.
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Adjust improper peak
integrations

The table below describes what to do if the peaks in the curve window do not appear
to be integrated properly (for example if ghost peaks are numerically labeled).

ActionStep

Click the Cancel button to quit the wizard.1

Perform a peak integration (see Section 5.2 Peak integration, on page 102)
and verify that the resulting curve is properly integrated.

2

Repeat the Multi Result Peak Compare wizard operation.3

Step 3: Select the peaks
All peaks identified during the peak integration are numerically labeled. In this step the
peaks of interest are selected in the Peak Selection dialog, first manually in one curve,
then automatically in all selected curves.

Select the peaks in the first curve

• Double-click a peak in the curve window or click the peak once and then click the
Select peak button.

Result: The peak is assigned an identification letter (A, B, C....) in Sel column in the
Peak data table and under the peak in the Curves window. A row with the peak pa-
rameters is added in the Peak Identification Settings. The order of the letter is deter-
mined by the order of the selection.

• Repeat the selection for all peaks of interest in the curve.

Click and drag in the curve window to zoom into selected peaks to simplify
accurate peak identification. Right-click and click the Reset Zoom button to
reset the zoom to the full view.

Tip:

Select identification criterion for each peak in the first curve
Set the desired peak identification criterion:

• Click the desired parameter in the Peak Identification Settings table. For example,
if you have selected the highest peak in the curve and want to compare the highest
peak among all curves, select the Height check box. The available parameters are:

- Area: Same relative area size.

- Number: Same number in order after elution.

- Height: Same relative height.

- Retention: Same retention value.
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- Peak name: Same peak name.

• Repeat the selection for all peaks of interest in the first curve.

Result: Based on this selection, UNICORN locates the corresponding peaks in all selected
curves and assigns the same identification letters.

More than one peak in a curve may fulfill the selected identification criteria.Note:

In the illustration below, only the first peak has been selected and has therefore been
assigned the identification letter A. It is the third highest peak and has therefore 3 as
Height in the Peak Identification Settings table. Retention has been selected as identi-
fication criteria:

Verify the peak identification in all selected curves
Use the Next curve and Previous curve buttons to navigate forward and backward
among your selected curves and manually check the peak identification made by the
software. Verify that UNICORN has identified the correct peaks in the Peak Identification
Settings table and/or curves window of each curve.

If UNICORN has identified other peaks than the intended ones, you can change the peak
identification manually according to the table below:
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then...If you want to...

• click the desired peak in the curves window

• click the Set as peak button

• choose None in the Set As Peak dialog

• click OK.

Result: The peak in this curve will not be included in the
statistical calculation. The peak identification letter is re-
moved from the curves window.

remove a peak identifi-
cation

• click a peak in the curves window

• click the Set as peak button

• choose a letter in the Set As Peak dialog

• click OK.

Result: The peak identification letter is replaced/added in
the curves window and Peak data table, and the row is
edited/added in the Peak Identification Settings table.

Note:

A red asterisk will be displayed in front of the identification
letter of all peaks that have been selected, to show that
the peak was not selected automatically by UNICORN.

replace or add a peak
identification

• select the row

• click the Delete row button.

Result: All peaks with the same identification letter in the
selected curves are excluded from the statistical calcula-
tion. The peak identification letter is removed from the
curves window and Peak data table, and the row is re-
moved from the Peak Identification Settings table.

Note:

If you click Delete row without first selecting a row, the
first row (A) is deleted by default.

remove a row from the
table

Other possible actions you can perform
If desired, you can assign a name to a chosen peak:

• Click the peak label of the row, for example A.

• Click the Set peak name button.
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• Type a new name and click OK.

Result: All peaks labeled A in the selected curves are assigned the name.

This can be useful when you comparemultiple peak parameters and youwish
to have peak names other than “Peak A”, “Peak B”, etc., to simplify evaluation
of the comparison.

Tip:

If desired, you can change the choice of curves.

• Click the Delete curve button to delete a curve from the comparison, if it does not
prove useful for your comparison.

• Click the Back button to navigate back to the Data Selection dialog to add new
curves to your comparison.

Peak selection completion

• Verify the identification of the corresponding peaks in the selected curves again, if
necessary.

• When all peak selections and identification settings are complete, click the Next
button to proceed to the Peak Data Selection dialog.

Step 4: Select the Peak Data
The illustration below displays the Peak Data Selection dialog:

The table below describes how to select the peak data:
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ActionStep

• In the Select Peak Data list, select the peak characteristics on the list
that you want to include in your comparisons.

• If available, select the appropriate Scouting variables.

1

• Click the Next button and proceed to "Step 5: The Data View dialog"
below.

2

Step 5: The Data View dialog
The Data View dialog presents a statistical comparison of the chosen data for the des-
ignated peak comparisons. The illustration below shows the dialog. In this example, there
are three curves and two identified peaks. Peak A has been named Protein 1, and peak
B named Protein 2.

The table below describes how to use the command buttons of the dialog:

FunctionCommand button

Opens a preview dialog showing what the Data View
spreadsheet will look like when printed.

Print Preview

Prints the spreadsheet.Print

UNICORN 7.0 Evaluation Manual 29-1108-88 AA 189

5 Evaluate results
5.6 Multi Result Peak Compare wizard



FunctionCommand button

Allows you to save the result from the multi result peak
comparison as:

Save Spreadsheet

• an Excel file (.xls)

or

• Tabbed text (.txt)

See "Save the Wizard Settings" below.Save Wizard Settings

Ends the Multi Result Peak Compare wizard.Close

Save the Wizard Settings
The settings from the comparison can be saved, in order to use the same settings on
other results. The table below describes how to save the wizard settings:

ActionStep

• Click the Save Wizard Settings button.

Result: The Save Wizard Settings dialog opens.

1

Type a name in the Wizard settings name field.2

• If the settings are to be used by all users on the system, select the
Global wizard settings checkbox.

• Click OK.

• Click Close to close the wizard.

Tip:

The Global wizard settings checkbox can also be used to toggle between
lists of stored global and stored user settings.

3

Open the stored wizard settings
The table below describes how to open the stored wizard settings:

ActionStep

• Open the Multi Result Peak Compare wizard and click the Select Stored
Wizard Setting button.

Result: The Select Wizard Settings dialog opens.

1
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ActionStep

• Select the desired saved settings from the list.

• Click OK.

Result: TheMulti Result PeakComparewizard opens with the saved settings.

Tip:

TheGlobalWizard Settings checkbox is used to toggle between lists of stored
global and stored user settings.

2
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5.7 Rename folders, results, chromatograms, curves and
peak tables

Rename folders and files
Folders and files may be renamed in the Result Navigator either by

• right-clicking the object and choosing Rename from the shortcut menu

or

• choosing Edit:Rename:Navigator Object

This will highlight the name of the selected object and you can type a new name instead.

You cannot rename assigned home folders.Note:

Renamechromatograms, curves
and peak tables

The table below describes how to rename chromatograms, curves or peak tables in the
Evaluation Classic module.

ActionStep

Choose Edit:Rename and the relevant option Chromatogram, Curve or
Peak Table.

1

Result: The Rename dialog opens.

• Select the appropriate object.

• Type a new name in the Name field.

• Click OK.

2

The original chromatogram or original raw data curves cannot be renamed.
They will not be available in the Rename dialog.

Note:
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5.8 Sign results electronically

Instruction
Result files can be signed electronically to enhance data file security. The table below
describes how to sign a result file electronically in the Evaluation Classic module:

ActionStep

Choose File:Sign Result.1

Result: The Sign Result dialog opens.

The Sign result tab shows the properties for the current user. You can also
choose another user from the droplist. If you choose a new user, the corre-
sponding password must be typed in the Log on password text box.

2

• Type your log on password in the Log on password field.

• Type a short text description for the signed operation in the Signature
description field (e.g. "peak integration performed").

The Lock check box is selected as default, to lock the result file from further
changes.

Note:

You should only lock the result when you are sure that the result file will not
be modified anymore.

• Type your signature password in the Signature password field.

• Click OK.

3
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Signatures associated with the
result

The View Signatures tab of the Sign Result dialog provides a list of all signatures asso-
ciated with the current result. The information on this tab is for viewing purposes only
and cannot be changed.
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5.9 Save results

Introduction
After you have finished the evaluation process, you can save all the changes you have
made to the chromatograms, including newly created curves and chromatograms that
you have imported and created.

Delete unwanted curves
All the curves that you created during your manipulations will be saved in the chro-
matogram. If some of these curves are no longer needed, select Edit:Delete:Curves in
the Evaluation Classic module to remove the curves.

The original curves that were created during the run can never be deleted.Note:

Save the results
You can either save your edited results in the original file or in a new result file. The table
below describes how to save the results in the Evaluation Classic module.

then...If you want to save the
edited results...

• select File:Save.

or

• click the Save toolbar icon.

in the original result file

• select File:Save as.in a new result file

The previous version of the result filewill be overwritten if you save the changes.
This cannot be reversed. However, the raw data curves remain unchanged.

Note:
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Exit the Evaluation Classic
module

The table below describes how to exit the Evaluation Classic module:

then...If you want to...

click the red cross icon in the top right corner of the
module window.

close only the
Evaluation Classic mod-
ule

choose File:Exit UNICORN.exit UNICORN

If there are unsaved changes, a dialog box opens with an option to save the
changes before exit.

Note:
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6 Import and export of folders and
results

About this chapter
This chapter describes how to import and export folders as well as results in different
formats.

In this chapter
This chapter contains these topics:

See pageSection

1986.1 Import and export folders

2016.2 Import results

2046.3 Export results
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6.1 Import and export folders

Import folders
Folders containing for example methods, method queues and/or DoE Results can be
imported into UNICORN. The table below describes how to do this.

ActionStep

Select File:Import:Folder(s)....1

Result: The Import dialog opens.

Browse to the folder of interest (*.UFol) in the Import dialog.2

Open the folder by selecting it and clicking the Open button.3

If the folder contains method queues a System Mapping dialog opens.4

Select a Target system for each Original system listed.

Note:

Toproceedwith the import, theremust be at least the samenumber of systems
active in UNICORN as the number of original systems.
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ActionStep

Click the Import button to import the folder with all its content.

Note:

For a folder containing several method queues, the System Mapping dialog
is only shown once.

5

During the import of a folder an Import Report is generated at the target lo-
cation.

Note:

Export folders
Folder export is recommended for bulk export of all items residing in a folder. During
folder export everything in the folder is exported regardless of application or object
navigator filter settings. If the folder contains compound objects, such as method queues
or DoE results, all individual items located outside the exported folder will be placed to-
gether with the exported folder.

The following table outlines the steps needed to export a folder containing for example
methods, method queues and/or DoE Results for later import into UNICORN.

ActionStep

• Select a Folder in the Object Navigator. To select several Folders, press
Shift while you click the folders.

• Choose File:Export:to UNICORN:Folder(s)...

1

Result: An Export dialog opens.
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ActionStep

2

Click OK to continue the export.

Result: The Export to Another UNICORN database dialog opens.

Choose a location and click the Save button to save the folder.3

Result:

• The folder is exported as a .UFol file.

• An Export Report is generated at the target location.

Note:

Export of multiple folders results in the generation of a single export file.
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6.2 Import results

Introduction
This section describes how to import curves and result data.

During the result import an Import Report is generated at the target location.Note:

Import curves
Individual curves saved in ASCII format (as *.asc or *.txt files) may be imported into the
active chromatogram. The table below describes how to import curves:

ActionStep

• Choose File:Import:Curves.

Result: The Import dialog box opens.

1

• Locate the file that contains the curve and click the file.

• Click the Open button.

Result: The Import Curves dialog opens, showing the available curves in the
file.

2

• Select the curve(s) to import.

• Click the OK button.

Result: The curves are opened in the active chromatogram.

3

A curve can only be imported in the base unit that it was exported in. For vol-
ume base, the curve is shown in chromatogramwith ml and CV as X-axis. For
time base, the curve is shown in in chromatogram with min as X-axis.

Note:

Import results
Results that have been exported from a UNICORN database may be imported into the
database again. The table below describes this:

ActionStep

• Choose File:Import:Entire Result(s)...

Result: The Import dialog opens.

1
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ActionStep

• Locate and click the zip-file that contains the result. To select several
files, press Shift while you click the files.

• Click the Open button.

Result: The Import Result dialog opens.

2

• Select the destination folder for the result.

• Click the Import button.

Result: The result files are individually unzipped and imported into the selected
folder.

3

A result file cannot be imported into a folder if the folder already contains a
result with the same name. In that case you must rename the file.

Note:

Import DoE results
DoE results that have been exported from a UNICORN database may be imported into
the database again. The table below describes this:

ActionStep

Select File:Import:DoE Result(s)...1

Result: The Import dialog opens.

Browse to the DoE result file (*.UdoE) of interest in the Import dialog.2

Open the file by selecting it and clicking the Open button.3

Click the Import button to import the DoE results.4

DoE results may also be imported by importing an entire folder, see Import
folders, on page 198.

Note:
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Import results from UNICORN 5
Results that only contain original data and have been created in UNICORN 5.11 or sub-
sequent versions can be imported into UNICORN 7.0. These are saved as .res files, not
.zip files. The results can be used for comparison with results created in UNICORN 7.0.
Import from UNICORN 5 is available for results created with some CU based systems,
for example, ÄKTApilot™ and ÄKTAprocess™.

The table below describes how to import result data from UNICORN 5:

ActionStep

Select the destination folder where you want the imported results to be
shown in the Result Navigator Results tab.

1

Choose the File:Import:Entire Result menu command.2

Result: The Import dialog opens.

Choose UNICORN 5.* Result Files(*.res) as format in the Files of type field.3

Locate and select the result files in the navigation field

Tip:

You can select several results at once by using the shift or Ctrl keys when
selecting.

4

Click the Open button5

Result: The selected results are imported into the database and shown in
the Result Navigator in the selected destination folder.

Changes in data after import
When results are imported from UNICORN 5, there is some information that will not be
included. It is important to review the data after import, to verify that all essential infor-
mation is there. All functionality in UNICORN 7.0 is not available for imported results,
since necessary data might be missing.

DescriptionAffected information

Any analysis module related data is not migrated.Analysis module related data

For results containing pooled fractions, the pooling
curve will be included but not the pooling table.

Pooling

Result layouts are not migrated.Result layout

It is not possible to re-create a method in UNICORN
7.0 from a result that has been migrated from
UNICORN 5.

Re-create method from result
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6.3 Export results

Introduction
This section describes how to export entire results and result items, including

• curves

• DoE results

• documentation

• peak tables

and

• Design of Experiments projects

The section also describes how to copy items using the Windows clipboard.

During the result export an Export Report is generated at the target location.Note:

Export options
Select File:Export in the Evaluation Classic module to export data from an open result
file. The following export options are available:

Then the options are...If you choose...

• Curves

• Entire Result(s)...

• DoE Result(s)...

or

• Folder(s)...

to UNICORN

Export of a Design of Experiments to a MODDE™ 9 Inves-
tigation Project file.

Design of Experiments
- Modde

• Curves

• Peak Table

• Documentation

or

• Copy to Metafile

Externally
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These options are explained further below. (Folder export is described in Export folders,
on page 199.)

Export entire results
One or several entire results may be exported for use in another UNICORN database.
The table below describes how to do this:

ActionStep

• Select a result in the Result Navigator. To select several results, press
Shift while you click the results.

• Select File:Export:To UNICORN:Entire Result.

Result: The Export to Another UNICORNDatabase dialog opens if one result
was chosen. The Browse For Folder dialog opens if several results were
chosen.

1

Result files are exported as compressed .zip files only.2

• Select an export location. Make a new folder if desired.

• Type a name in the File name field in the Export to Another UNICORN
Database dialog if one result was chosen.

Note:

As the results are exported individually, it is not applicable to enter a
destination file name if several results are selected for export.

• Click Save in the Export to Another UNICORN Database dialog or OK
in the Browse For Folder dialog.

Result: The result is saved as a zip file. If several results were exported, each
result is saved as an individual zip file.

3
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Export DoE results
DoE results may be exported for use in another UNICORN database. The table below
describes how to do this:

ActionStep

• Select a DoE result in theResult Navigator. To select several DoE results,
press Shift while you click the results.

• Select File:Export:To UNICORN:DoE Result(s)...

Result: A DoE Export dialog opens

1

2

• Click OK to continue the export.

Result: The Export to Another UNICORNDatabase dialog opens if one result
was chosen. The Browse For Folder dialog opens if several results were
chosen.

DoE Result files are exported as .UdoE files.3

• Select an export location. Make a new folder if desired.

• Type a name in the File name field in the Export to Another UNICORN
Database dialog if one result was chosen.

Note:

As the results are exported individually, it is not applicable to enter a
destination file name if several results are selected for export.

• Click Save in the Export to Another UNICORN Database dialog or OK
in the Browse For Folder dialog.

Note:

Export ofmultiple DoE results results in the generation ofmultiple export files.

4
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DoE results may also be exported by exporting an entire folder, see Export
folders, on page 199.

Note:

Export curves
The table below describes how to export curves in the Evaluation Classic module.

ActionStep

• Choose File:Export:To UNICORN:Curves.

or

• choose File:Export:Externally:Curves

Result: The Export Curves dialog opens.

1

• Select the curve(s) you want to export.

• Enter parameters to limit the curve(s) if necessary (described in "Limit
the exported curves" below).

• Click the Select >> button.

• Repeat this step to select more curves.

2

Click the Export button.3

Result: The Export Curves to File dialog opens.
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ActionStep

Select the export file format from the Save as type droplist.4

• ASCII files (*.asc)

or

• Comma Separated Values (*.csv)

• Select a destination folder.

• Type a file name and click Save.

5

Curves are exported as series of numerical coordinates that refers to the
time/volume and signal respectively.

Note:

Limit the exported curves
You can optimize the exported curves to only the parts that you want to focus on, in the
Export Curves dialog. The table below describes how to use these editing options.

InstructionOption

Enter retention values in the text boxes to limit the curve
to only a portion of the original curve.

Cut curves

This button opens a graphicalExport Curves dialog. Move
the vertical markers to the correct cutoff points.

Cut graphically

Adjust the factor value or the maximum number of samples.
To reduce the number of samples by a factor of five means
that only every fifth point will be sampled for export.

Reduce number of
samples
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InstructionOption

Select theNormalize retention checkbox to have all export-
ed curves normalized to a common X-axis.

Normalize retention

Export peak tables
The table below describes how to export peak tables.

ActionStep

Choose File:Export:Externally:Peak Table.1

Result: The Export Peak Table dialog opens.

• Select the source chromatogram and the peak table you want to export.

• Click the Export button.

Result: The Export Peak Table To File dialog opens.

2

Select the export file format from the Save as type droplist:3

• ASCII files (*.asc)

• Excel files (*.xls)

• XML files (*.xml)

• Select a destination folder.

• Type a file name.

• Click Save.

4

Peak tables are exported as text strings in ASCII or XML format and numerical
values in the Excel format. All possible columns in the peak table are exported.

Note:
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Export documentation
The table below describes how to export the run documentation:

ActionStep

• Choose File:Export:Externally:Documentation.

Result: The Export Peak Table dialog opens.

1

• Select the report items you want to include in the exported documenta-
tion.

Tip:

Sub-menu items are available only if the top item is selected. For example,
youmust selectMethod Information first to be able to select Information
and Signatures.

2

• Click the Export button.

Result: The Export Documentation to File dialog opens.

3

Select the export file format from the Save as type droplist:4

• ASCII files (*.asc)

• Excel files (*.xls)
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ActionStep

• Select a destination folder.

• Type a file name.

• Click Save.

5

Export the chromatogram to a
Windows metafile

You can export an image of the open chromatogram as a Windows enhanced metafile.
This image format can be used in other applications, for example Microsoft® Word or
PowerPoint®. The table below describes this export:

ActionStep

• Choose File:Export:Externally:Copy to Metafile

or

• Right-click in the chromatogram and choose Copy to Metafile

Result: The Export Chromatogram to Windows Enhanced Metafile dialog
opens. The only available file type is Enhanced Meta File (*.emf)

1

• Select a destination folder.

• Type a file name.

• Click Save.

2

Export Design of Experiments
Design of Experiments may be exported for use in the Design of Experiments application
MODDE. The design is exported in the specific format MODDE 9 Investigation Project
(*.mip).

The evaluation of Design of Experiments results is described in the UNICORN
Method Manual.

Tip:
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Copy to the clipboard
You can use the Windows clipboard to copy the contents of the active window and paste
it into other programs. The table below describes how to do this:

ActionStep

• Choose Edit:Copy

or

• Right-click and choose Copy to Clipboard

or

• Click the Copy icon

Result:

1

• If the active window only contains a chromatogram, it will immediately
be copied to the clipboard as a Windows metafile.

• If the active window also contains a peak table, the Copy to Clipboard
dialog opens.

Select one of the options:2

• Copy curve window as enhanced meta file

• Copy selected peak table data as tabbed text

Click the OK button.3
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7 Other evaluation operations

About this chapter
This chapter describes how the results can be used for other types of evaluations. It also
contains information about how to automate frequently used evaluation procedures.

In this chapter
This chapter contains these sections.

See pageSection

2147.1 Curve operations

2267.2 Evaluate a column performance test

2317.3 Automated evaluation procedures
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7.1 Curve operations

About this section
This section describes:

• How to evaluate single curve data points in chromatograms

• How to reduce the noise from curves and remove ghost peaks

• How to use arithmetic operations on curves

and

• How to find slope values that can be used for example as watch instruction param-
eter values

In this section
This section contains these subsections:

See pageSection

2157.1.1 Evaluate single curve data points

2187.1.2 Reduce noise and remove ghost peaks

2207.1.3 Add, subtract or divide curves

2237.1.4 Find slope values
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7.1.1 Evaluate single curve data points

Introduction
It is possible to determine the coordinates of any point on a curve and to obtain values
for retention and peak height. This is a useful tool for many other functions, such as for
measuring the parameters used in baseline calculations.

Measurement options
Coordinates can be obtained in two ways:

• Through direct measurement.

• From peak table data.

Direct measurements
The table below describes how to make direct measurements in a chromatogram:

ActionStep

Right-click in the chromatogram and select Vertical marker.1

Result: A vertical line is set in the chromatogram. A text box in the top left
corner of the chromatogram displays the X-axis and Y-axis values of the
curve at the point where the marker line crosses the curve. See the illustration
below:

Tip:

The color of the Vertical marker is the same as the selected curve.

UNICORN 7.0 Evaluation Manual 29-1108-88 AA 215

7 Other evaluation operations
7.1 Curve operations

7.1.1 Evaluate single curve data points



ActionStep

Move the marker with your mouse to display the peak position in X-axis and
Y-axis values. The mouse pointer changes into a double-headed arrow when
it is properly placed over the marker.

2

Click the curve name legend above the chromatogram to change to another
curve.

3

Result: The Y-axis is changed to the one corresponding to the new curve.

Right-click and select Vertical marker again to de-select the function.4

Set a reference point
The table below describes how to set a reference point:

ActionStep

• Right-click in the chromatogram and select Vertical marker.

• Move the marker with your mouse to the place for the reference point.

1

Right-click in the chromatogram and select Set vertical marker reference
point to define a reference point for the marker position.

2

Drag the marker away from the reference point and read the X-axis and Y-
axis values for the new position. You can also read the

3

• Delta

• Mean

• Min

and

• Max

curve values for the interval between the reference point and the new posi-
tion.

The curve interval between the reference point and the new marker position
is shaded in the chromatogram.

Note:

216 UNICORN 7.0 Evaluation Manual 29-1108-88 AA

7 Other evaluation operations
7.1 Curve operations
7.1.1 Evaluate single curve data points



Record a Snapshot
The table below describes how to record a Snapshot of the curve values at a specific
volume or time point:

ActionStep

• Right-click in the chromatogram and select Vertical marker.

• Move the marker with your mouse to the place for the snapshot.

1

Right-click in the chromatogram and select Snapshot from the shortcut
menu.

2

Result: The Snapshot dialog opens.

The dialog displays all the curve data for the Y-axis value where the snapshot
was taken.

3

• Click the Save button to save the snapshot as a text file.

• Click the Print button to print the snapshot.

Click the Close button to close the dialog.4

Select peak table data
The retention time and amplitude of any peak can be viewed directly in a peak table
after an integration. These data and more are selected in the chromatogramCustomize
dialog. The table below describes how to select peak table data.

ActionStep

Click the Customize icon.1

Result: The Customize dialog opens.

Click the Peak Table tab of interest.2

• Select the checkboxes on the Select peak table columns list for all items
that you want to display in the table.

• Click OK.

3
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7.1.2 Reduce noise and remove ghost peaks

Introduction
Sometimes the chromatograms contain curves with a noisy baseline. The noise can be
caused by several factors, for example a dirty flow cell, air bubbles, electrical noise, dirty
buffers, etc. The amount of noise can usually be reduced by taking proper precautions,
for example filtration of buffers and instrument maintenance.

You can also use the smoothing function to reduce or remove background noise from
a selected curve. Smoothing is always a compromise between noise removal and
preservation of peak shape.

Smooth a curve
The table below describes how to select a smoothing function and smooth a curve:

ActionStep

Select Operations:Smooth.1

Result: The Smooth dialog box is displayed.

Select the curve to be smoothed and its target destination.2

Select the Filter type to be applied. The options are:3

• Moving average

Use this if you have noise along most of the curve. It affects peak height
but not retention. There is little effect on the peak area.

• Autoregressive

Use this if you have periodic noise along the whole curve. It affects peak
height and retention, although this has little effect on the peak area.

• Median

Use this if there is only one or a few noise spikes, for example caused
by air bubbles, or if the noise is confined to only a small part of the curve.
It can flatten peaks and affect peaks areas slightly, but does not affect
retention.

• Savitzky-Golay

Use this to calculate the smoothing and differentiation of data by a least
squares technique.

218 UNICORN 7.0 Evaluation Manual 29-1108-88 AA

7 Other evaluation operations
7.1 Curve operations
7.1.2 Reduce noise and remove ghost peaks



ActionStep

Select an appropriate smoothing parameter value from Light to Hard for
the selected filter in the Filter Parameters field. Use the slider, or insert a
value manually in the text field. The manual value has the same unit as the
chromatogram. The smoothing effect increases with increasing parameter
values.

4

• Click OK.

Result: A smooth curve is added to the chromatogram. By default, smoothed
curves are given the suffix SMTH. The default curve name can be changed
as needed.

Start with a low parameter value, for example the default value, and increase
it until the best result is achieved. A useful strategy is to increase the parameter
value by the default value for each try.

Tip:
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7.1.3 Add, subtract or divide curves

Introduction
In some method runs, several sequential chromatograms might have been created. This
can occur, for example, when the instruction New chromatogram has been used in the
method, thus creating different chromatograms during the run. In order to view and
evaluate the resultant curve of all the chromatogram parts, the curves must be added
together. Usually, you have a number of chromatograms within the same result file and
you want to add the curves. In some circumstances, curves might need to be imported
from other result files.

Sometimes the presentation of a curve may benefit if a blank run curve or a baseline
curve is subtracted from the curve. For example, this is useful when the curves have a
drifting baseline or ghost peaks.

Curves may also be divided, for example to determine the ratio between curves as a
means to study peak purity or to identify peaks. This is described in Section 5.4.4 Peak
purity and peak identification, on page 158.

Add curves
The table below describes how to add several curves to form a combined, cumulative
curve:

ActionStep

Select and view the first chromatogram in the sequence.1

Choose Operations:Add.2

Result: The Add dialog is displayed.

• Select the source chromatogram in the chromatogram list and the first
curve in the desired sequence in the left Source chromatogram and
curve field.

• Select the chromatogram in the chromatogram list and the second curve
in the sequence in the middle Source chromatogram and curve field.

Note:

The suggested curve number is highlighted in the Target chromatogram
and curve field. A default name is displayed in the Curve name box.

• Click OK to add the two curves together in a new result curve in the first
source chromatogram.

3
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ActionStep

• Open the Add dialog again to add more curves to the result curve.

• Select the chromatogram in the chromatogram list and the result curve
(.ADD) from the previous addition in the left field.

• Select the chromatogram in the chromatogram list and the next curve
in the sequence in the middle field.

• Click OK to add the two curves together in a new result curve in the first
source chromatogram.

4

Repeat step 4 until all curves have been added together. The final curve
should be the cumulative curve for the whole run.

5

All curves created using the Add operation receive the ADD suffix by default.
The default curve name can be changed as needed. The original curves are
distinguished in the chromatogram by underlined curve names.

Note:

Subtract curves
The table below describes how to subtract curves:

ActionStep

Choose Operations:Subtract.1

Result: The Subtract dialog is displayed.

• Select the chromatogram in the chromatogram list and the first curve
in the left Source chromatogram and curve field.

• Select the chromatogram in the chromatogram list and the curve you
want to subtract from the first curve in the middleSource chromatogram
and curve field.

2

• Click the OK button.

Result: The second curve is subtracted from the first and a new result curve
of the difference is created in the first source chromatogram.

3

All curves created using the Subtract operation receive the SUB suffix by de-
fault. The default curve name can be changed as needed. The original curves
are distinguished in the chromatogram by underlined curve names.

Note:
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Divide curves
The table below describes how to divide curves:

ActionStep

Choose Operations:Divide.1

Result: The Divide dialog is displayed.

• Select the chromatogram in the chromatogram list and the first curve
in the left Source chromatogram and curve field.

• Select the chromatogram in the chromatogram list and the curve you
want to divide the first curve with in the middle Source chromatogram
and curve field.

2

If necessary, select the Threshold option and enter Y-axis threshold values.
You may enter different values for each curve.

3

This option is available only for theDivide operation. If one of the two curves
that are divided has values below the threshold, the resulting curve value
will be 1 at those data points.

• Click the OK button.

Result: The first curve is divided by the second and a new result curve of the
quotient is created in the first source chromatogram.

4

All curves created using theDivide operation receive theDIV suffix by default.
The default curve name can be changed as needed. The original curves are
distinguished in the chromatogram by underlined curve names.

Note:
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7.1.4 Find slope values

Introduction
With ÄKTA™ design systems it is possible to just collect peaks by conditional peak frac-
tionation. The way to find suitable slope values for a particular run is described in this
section.

Where to use slope values
The slope values can be used in the Method Editor

• as Start slope and End slope values in the Peak Fractionation Settings.

• as parameters for the Watch instruction.

Using slope values for Watch instructions
Conditional Watch instructions can be set up to let the progress of a run be determined
by the events during the run (e.g., start to collect fractions when the first peak emerges).

The slope of the curve can be set as a condition to satisfy a Watch condition in the
method during the run. It is important to use accurate slope values for the specificWatch
instruction parameter.

A sample run
You must first make a separation run with the sample you intend to purify. The result
from this separation run is then used to find the slope values.
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Retention scale
Time should be used as the X-axis scale for retention.

ActionStep

Click the Customize icon.1

Result: The Customize dialog opens.

• Click the X-axis tab.

• Select Time in the Base field.

• Click OK.

2

Differentiate the curve
The slope values are measured on a differentiated curve. The table below describes how
to create a differentiated curve.

ActionStep

Select Operations:Differentiate.1

Result: The Differentiate dialog opens.

• Select the chromatogram and the UV curve you want in the Source
chromatogram and curve list.

• Click the First order option button.

2

• Click OK.

Result: The differentiated curve opens in the chromatogram.

3

Measure the slope values
Sometimes the differentiated curve must be filtered to reduce noise and ghost peaks
before the measurements. See section Section 5.4.4 Peak purity and peak identification,
on page 158.

The table below describes how to measure the slope values on the differentiated curve.

ActionStep

Select the differentiated curve (The text Differentiation will be shown in
brackets above the Y-axis.).

1
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ActionStep

Use the zoom function to magnify the curve over an appropriate area.2

Right-click and select Vertical marker from the shortcut menu.3

Result: A vertical marker bar opens in the chromatogram.

Place the marker at the beginning of a peak where you want the Watch
conditions to be fulfilled (i.e. where the slope becomes higher).

4

Read the actual slope value in the active marker text box in the top left corner
of the chromatogram pane.

5

The unit for the differentiated curve is mAU/min or AU/min. Any Y-axis value
for the differentiated curve is the UV curve slope at the selected retention point.

Note:

Measure the slope at the beginning and the end of the smallest, flattest peak
of all the peaks of interest, and use these values.

Tip:

Illustration: Slope value
measurement

The illustration below shows a measurement of the slope limit after differentiation:
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7.2 Evaluate a column performance test

Introduction
The quality of the packed bed of a column is checked by performing a column perfor-
mance test. Tests should be made directly after packing and at regular intervals during
the working life of the column and also when separation performance is seen to deteri-
orate. The best method of expressing the efficiency of a packed column is in terms of
the height equivalent to a theoretical plate (HETP) and the asymmetry factor (As). The
column performance test calculates these values, which can be stored as statistics in
the Column Logbook.

The calculated plate number will vary according to the test conditions and it
should only be used as a reference value. It is important that test conditions
are kept constant so that results are comparable. Changes of solute, solvent,
eluent, sample volume, flow velocity, temperature, etc. will influence the results.

Note:

Refer to the column and/or media instructions for suggested solvents, flow
rates etc.

Tip:

Method formeasuringHETP and
As

The column performance test calculates HETP and As from the integrated UV curve as
follows:

HETP calculations

L = Bed height (cm)
L 
N 

HETP = N = number of theoretical plates

VR = retention volume

Wh = peak width at half heightVR 

Wh 
N = 5.54 ×  

2 

VR and Wh are in the same units.

The concept of reduced plate height is often used for comparing column performance.
The reduced plate height is calculated as follows:
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d50v is the mean diameter (m) of the beads.
HETP

d50v

As a guideline, a value of <3 is normally acceptable.

Peak asymmetry factor
The peak should be symmetrical, and the Asymmetry factor as close to 1 as possible.
Values between 0.8–1.6 are usually acceptable. A change in the shape of the peak is
usually the first indication of bed deterioration due to excessive use.

Peak asymmetry factor calculation:

a = 1st half peak width at 10% of peak heightb 
a 

As = 
b = 2nd half peak width at 10% of peak height.

Illustration of a curve
The illustration below shows a UV curve for acetone in a typical test chromatogram from
which the HETP and As values are calculated.

VR 

Wh 

50% 

10% 

Volume 

a b 

Absorbance 
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Evaluate the column
performance test

Follow the instruction below to evaluate a column performance test.

ActionStep

Browse for and open the column performance test result in the Result
Navigator in the Evaluation Classic module.

1

Result: A dialog is displayed and describes how to save the column perfor-
mance statistics in the Column Logbook. It is not necessary to close this
dialog to proceed with the peak integration.

Perform a peak integration as described in Section 5.2.2 Perform a peak in-
tegration, on page 105. Select the UV (280) curve.

Note:

By default, all peaks except the largest will be rejected at the peak integration.

When evaluating the performanceof custompacked columns (e.g. AxiChrom™
columns), the measured bed height should be entered in the Column height
(bed height) field of the Peak Integrate dialog. The bed height for the column
type will be used by default if the measured bed height for the individual col-
umn is not entered.

2
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ActionStep

Select the peak for column performance statistics in the peak table by
clicking the peak number.

3

To store the column performance result as statistics for the individual column
in theColumnLogbook, right-click the selected row and select Save Column
Performance Statistics.

4

UNICORN 7.0 Evaluation Manual 29-1108-88 AA 229

7 Other evaluation operations
7.2 Evaluate a column performance test



ActionStep

• Click the Column Handling icon.

• Select the Column Logbook tab.

Result: Column Performance statistics for the individual column is displayed
in the Column Logbook table. The Column Data include

5

Asymmetry, Plate height and Plates per meter.

Changing the bed height for an individual column (for example an AxiChrom
column) in the Peak Integrate dialog will not automatically change the bed
height for the column type. To be able to create methods that are based on
the correct bed height for this individual column, youwill need to create a new
column type with this bed height and choose the type when creating the
method. This will ensure that the correct bed height is used.

Note:
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7.3 Automated evaluation procedures

About this section
Frequently used evaluation procedures can be recorded and saved. The saved sequence
of procedure instructions can be included as part of a method. When the method is run,
the evaluation procedures will be performed automatically. This section decribes how
to create and edit procedures and how to work with the Procedure Editor.

In this section
This section contains these subsections:

See pageSection

2327.3.1 Create a new procedure

2357.3.2 Edit a procedure

2387.3.3 Run a procedure

2427.3.4 Rename or remove procedures
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7.3.1 Create a new procedure

Introduction
You can use the Procedure Editor to record or create a new procedure. The Procedure
Editor can also be used to view and edit the instructions within a procedure. This section
describes how to use the Procedure Editor to record new procedures.

The Procedure Editor dialog
The illustration below shows the Procedure Editor in Record mode.

Record a procedure
The table below describes how to record a new procedure.

ActionStep

Open a result file in the Evaluation Classic module.1

Choose Procedures:New.2

Result: The Procedure Editor dialog opens in Edit mode.
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ActionStep

Start the recording

• Choose Control:Record

or

• click the REC icon.

3

Minimize the Procedure Editor dialog.4

Perform the evaluation steps that the procedure is to contain.5

Result: The steps are recorded in the order that they are performed.

Stop the recording

• Restore the minimized Procedure Editor dialog box and select Con-
trol:End Record.

or

• Restore the minimizedProcedure Editordialog and click the Stop button.

6

Choose File:Save or File:Save As in the dialog.7

Result: The Save As dialog opens.

• Type a name for the new procedure in the Procedure name text field.

• Select theGlobal procedure checkbox if desired (see further information
below).

• Click OK.

Result: The procedure is saved and available for future use, for example as
part of a method.

8

Click the Close button to close the dialog.9

UNICORN 7.0 Evaluation Manual 29-1108-88 AA 233

7 Other evaluation operations
7.3 Automated evaluation procedures

7.3.1 Create a new procedure



Create a Global procedure
You can choose to save the new procedure as a Global procedure. This makes the pro-
cedure available to all users. The procedure will have (Global) before the name to desig-
nate that it is available to all users.

Youmust belong to anAccessGroupwithCreate/Edit Global Objects autho-
rization to be able to save Global procedures.

Note:

Build a procedure with
instructions

You can select instructions in the Procedure Editor dialog to build a complete procedure
step by step. The procedure instructions are described in Appendix A.4 Evaluation proce-
dure instructions, on page265. The table below describes how to create a new procedure
with instructions.

ActionStep

Choose Procedures:New.1

Result: The Procedure Editor opens in Edit mode.

• Select an instruction type from the Instruction list (e.g.,Curve operation).

• Select the appropriate instruction from the field to the right of the instruc-
tion types.

• Select or type the appropriate parameter values in the Parameter field.

• Click Insert.

2

Repeat step 2 until the procedure is complete.3

Choose File:Save.4

Type a procedure name and click OK.5

Click the Close button in the Procedure Editor.6
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7.3.2 Edit a procedure

Introduction
Evaluation operations are represented by instructions in the Procedure Editor dialog
box. The instructions can be modified to suit other specific evaluation needs and be
saved for later use. This section describes how to use the Procedure Editor to edit a
procedure.

Edit a procedure
The table below describes how to edit an existing procedure:

ActionStep

Select Procedures:Edit:Open.1

Result: The Open Procedure dialog opens.

Select the procedure from the list and click OK.2

Result: The Procedure Editor opens in Edit mode.

Select an instruction in the procedure window.3

Result: The instruction and the corresponding parameters are displayed in
the Instruction and Parameter fields. A short definition of the selected in-
struction is displayed at the bottom left corner.

Type or select new values in the Parameter fields and click the Replace
button.

4

Result: The old parameters are replaced by the new parameters.

Add a new instruction5

• Select the instruction in the procedure immediately before where you
want the new instruction.

• Select a type and an instruction in the Instruction field.

• Select or type parameter values in the Parameter field.

• Click the Insert button.

Result: The new instruction is inserted after the selected instruction.

Remove an instruction6

Select an instruction in the procedure and click theDelete button to remove
the instruction from the procedure.
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ActionStep

• Choose File:Save

and

• click the Close button to close the dialog.

7

Descriptions of the procedure
instructions

Appendix A.4 Evaluation procedure instructions, on page265 contains a list of procedure
instructions with descriptions.

Add instructions to a procedure
by recording

If you start recording again you can add more instructions to a procedure that is already
open in the Procedure Editor:

• The new instructions will be added to the end of the present procedure.

or

• The new instructions will be inserted after the selected instruction if an instruction
has been selected.

Invalid instructions
The procedure will stop and display an error message if an instruction calls for an invalid
operation when the procedure is run. Any subsequent instructions in the procedure will
not be executed.

Address the right curves
Curves are identified only by their storage position. An instruction can become invalid if
it addresses the wrong curve:

Example

• The instructionADD (01,02,03)will try to add curve 01 to curve 02 and store the result
in position 03.

• A curve in position 03 that is not a raw data curve will be overwritten.
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• A raw data curve in position 03 cannot be overwritten and the procedure will be
stopped at that point.

Default values for classic
baseline instructions

When a classic or morphological algorithm is used to calculate a baseline, UNICORN will
suggest default values for the four control parameters based on the appearance of the
curve. To instruct UNICORN to use default values appropriate for the curve every time
the procedure is run, choose the default setting in the appropriate fields for the param-
eters.

Example

• CALCULATE_BASELINE (01, 06, XXX, XXX, XXX, XXX)

Can be changed to:

• CALCULATE_BASELINE (01, 06, DEFAULT, DEFAULT, DEFAULT, DEFAULT)

Global procedures
It is not advisable to edit existing global procedures. Open the global procedure instead
and save a copy under a new name. Use this copy for editing purposes.

UNICORN 7.0 Evaluation Manual 29-1108-88 AA 237

7 Other evaluation operations
7.3 Automated evaluation procedures

7.3.2 Edit a procedure



7.3.3 Run a procedure

Introduction
You can run the saved procedures either for a specific chromatogram or for multiple
chromatograms.

Run a single procedure
The table below describes how to run a procedure for a single, specific chromatogram.

ActionStep

Open a result file.1

Select Procedures:Run.2

Result: The Open Procedure dialog opens.

Select the procedure from the list and click OK.3

Result: The procedure is executed. A confirmation message is displayed.

You can also open the procedure in the Procedure Editor dialog and choose
Control:Run or click the Play icon.

Tip:

Runonmultiple chromatograms
It is possible to apply an evaluation procedure to a designated batch of several result
files if they are not open in the Evaluation Classic module. An open file will not run and
an error message will be displayed.

The run on multiple chromatograms is performed in the background of the Evaluation
Classic module and the results of the run are not seen, with the exception of prints and
documentation that are defined as steps in the procedure. For example, runs on multiple
chromatograms are useful

• to perform integration with the same parameter settings on many results,

or

• to print a number of results with the same settings.
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The Apply on Multiple
Chromatograms dialog

The illustration below is an example of search results in the Apply on Multiple
Chromatograms dialog:

Perform a procedure run on
multiple chromatograms

The table below describes how to perform a batch run on multiple chromatograms:

ActionStep

Choose Procedures: Run on Multiple Chromatograms.1

Result: The Open Procedure dialog opens.

Select the procedure from the list and click OK.2

Result: The Apply on Multiple Chromatograms dialog opens.
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ActionStep

Use the Browse buttons to find and select the folders, result files and chro-
matograms you want to search. Click the mouse button while pressing Ctrl
to select several items.

Tip:

The search will only be performed in the selected folder, result and/or chro-
matogram. You can use standard wildcard characters and define restricting
search criteria for theResultandChromatogram fields. Up to 10 user-defined
search filters can be saved in the drop-menus.

3

Click the Search button.4

Result: A list of found chromatograms is displayed.

Select the chromatograms you want to perform the run on.5

• The Select All button selects all chromatograms.

• The Clear button removes all chromatograms from the list.

Click the Run button.6

Result: The evaluation procedure is performed on each of the selected
chromatograms and any created curve or peak table will automatically be
saved in each result file.

Note:

A Batch Run Log will open after the last procedure run is performed, listing
any chromatogramwhere the procedure was unable to run. This dialog does
not open if all runs are successful.

Generate reports from multiple
chromatograms

Evaluation procedures applied on multiple chromatograms can be a useful tool to produce
printed documentation simultaneously for many result files (e.g., for a number of scouting
runs). The table below describes how to create a procedure to generate reports for sev-
eral results.

ActionStep

Start the recording of a new procedure and minimize the Procedure Editor.1

Choose File:Report.2

Result: The Generate Report dialog opens.
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ActionStep

Choose a report format.3

• Click the Print button.

Result: The Print dialog opens.

• Click the OK button.

• Click the Close button to close the Generate Report dialog.

4

Maximize the Procedure Editor and click the stop button.5

Save the procedure.

Tip:

A printing procedure can also be savedwith amethod, to produce automatic
prints at the end of a run.

6

When a procedure is applied on several results, the latest version of the proce-
dure will be used. However, procedures that are saved with a method are not
affected if the original procedure is edited at a later time.

Note:

Add procedures to the Quick
Menu

You can add selected evaluation procedures to the Procedures menu in the Evaluation
Classic module. The table below describes how to add procedures to the menu:

ActionStep

Select Procedures:Edit Quick Menu.1

Result: The Edit Procedures Menu dialog opens.

• Select the checkboxes of the procedures you want to display on the
menu.

• Click OK.

Result: The selected procedures are included on the Procedures menu.

2

Remove a procedure
Open the Edit Procedures Menu dialog and select the checkbox again to de-select and
remove a procedure from the menu.
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7.3.4 Rename or remove procedures

Introduction
The procedures that you have created can be renamed or removed from the list of
available procedures. This section describes how this is done.

Rename a procedure
The table below describes how to rename a procedure.

ActionStep

Choose Procedures:Edit:Rename.1

Result: The Rename Procedure dialog opens.

Select a procedure.2

Result: The procedure name is displayed in the New Name text box.

Type the new name.3

Click OK.4

Result: The procedure name is changed.

Delete a procedure
The table below describes how to delete a procedure.

ActionStep

Choose Procedures:Edit:Delete.1

Result: The Delete Procedure(s) dialog opens.

Select a procedure.2

• Click OK.

• Click the Yes button to confirm.

Result: The procedure is deleted.

3
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Global procedures
It is not advisable to edit existing global procedures. Open the global procedure instead
and save a copy under a new name. Use this copy for editing purposes.
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8 Troubleshooting

About this chapter
This chapter describes different problems that may arise when performing result evalu-
ations in UNICORN, and how to solve the problems.

Evaluation procedure aborts
The table below describes a problem and its solution:

SolutionProblemdescription

Instructions in an evaluation procedure refer to curves by
identification number irrespective of the curve names. Make
sure that the curves processed when the procedure is exe-
cuted are compatible with those processed when the proce-
dure was recorded. An evaluation procedure aborts if you
try to store the resulting curves at the position of an original
raw data curve.

The evaluation proce-
dure aborts

Maximum number of curves
exceeded

The table below describes a problem and its solution:

SolutionProblem description

The injection curve is also included for each
curve that is imported. Delete the unneces-
sary curves before importing more curves.

The maximum number of curves (100)
are exceeded when importing curves
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Distorted peaks
The table below describes a problem and its solution:

SolutionProblem description

A high UV averaging time value will distort and delay the
peaks. A high UV averaging time shall only be used when
very large and broad peaks are expected.

Peaks appear distorted

Columnperformance test errors
The table below describes problems and their solutions:

SolutionProblem description

Verify that the proper steps have been
performed during the evaluation.

The Column Performance Test attribute
is missing in the Run History

Verify that you have right-clicked on the
actual peak in the peak table when saving
the performance statistics.

No column performance parameters
are saved in the column logbook

Verify that the adjust zero retention value
is set to the injection.

The column performance parameter
values are wrong

Retention time differences
The retention value in the peak label in the chromatogram may differ from that in the
peak table or that in the X-axis. The table below describes problems and their solutions:

SolutionProblem description

Verify that the integration was performed on the
currently displayed chromatogram.

Note:

Only applicable if there are more than one chro-
matogram in the result.

The retention time in the
peak table differs from that
in the chromatogram.

Verify that the X-axis base has not changed after the
peak integration was performed, but is the same as
in the peak table. This is applicable for ml and CV
bases.

The retention value in the
peak label differs from that
in the X-axis.
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SolutionProblem description

• Verify that the X-axis base has not changed after
the peak integration was performed, but is the
same as in the peak table. This is applicable for
volume and time bases.

• Verify that the chromatogram has not been
changed, for example by selecting or deselecting
Adjust retention zero to injection number in the
Customize dialog, X-Axis tab.

The retention value is not
displayed in the peak label.

Import UNICORN 5 result errors
The table below describes a problem and its solution:

SolutionProblem descrip-
tion

• Verify that none of the suggested actions in the dialog are
applicable.

- A result with the same name already exists.

- You do not have sufficient access rights.

- The database is inaccessible.

• Make sure that the result is created by UNICORN 5 control
software and that the system is supported for data migra-
tion to UNICORN 7.0, i.e., see UNICORN Administration and
Technical Manual.

• Verify that the result can be opened in UNICORN 5, to make
sure that the file is not corrupt.

• Verify that the column that was used had ml as column
volume unit.

Not possible to im-
port UNICORN 5
results.
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Export of archived result
The table below describes a problem and its solution:

SolutionProblem description

Do not export an
archived result.

The export function is available when an archived result
is selected. However, it is not possible to export an archived
result. Instead the result that was selected before the
archived result will be exported.
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Appendix A Evaluation functions and
instructions

Introduction
This appendix contains background information about the algorithms and calculation
theories applied in UNICORN.

It also describes the peak table column components and the instructions that are
available for automated evaluation procedures.

In this appendix
This appendix contains these sections:

See pageSection

249A.1 Smoothing algorithms

252A.2 Baseline calculation theory

258A.3 Peak table column components

265A.4 Evaluation procedure instructions
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A.1 Smoothing algorithms

Introduction
This section describes how the smoothing functions are calculated. Choose Opera-
tions:Smooth in the Evaluation Classic module to view and edit the options.

Moving average
The table below describes the process when the Moving average smoothing algorithm
is used.

DescriptionStage

For each data point in the source curve, the processed curve is calculated
as the average of the data points within a window centered on the source
data point.

1

• The width of the window is determined by the Filter Parameter value,
expressed as number of data points.

When the source point is less than half the window size from the beginning
of the end of the curve, the average is calculated symmetrically round the
source point over as many data points as possible.

2

• If you increase the window width, the smoothing effect is also increased.

The filter algorithmonly accepts odd integer parameter values between 1 and
151. If an even number has been given, it is incremented by adding the number
one (1).

Note:

Autoregressive
The table below describes the process when the Autoregressive smoothing algorithm
is used:

DescriptionStage

The first data point in the source curve is copied to the processed curve.1

For each subsequent data point, the previous processed point is multiplied
with the filter parameter value and added to the current source data point.

2
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DescriptionStage

The result is then divided by the parameter value plus 1 according to the
following formulae:

3

Where:

tn = current processed point

tn-1 = previous processed point

Sn = current source point

p = smoothing parameter value

Note:

If you increase the parameter value, the smoothing effect is also increased.

The filter algorithm only accepts integer parameter values between 1 and 25.Note:

Median
The table below describes the process when the Median smoothing algorithm is used.

DescriptionStage

For each data point in the source curve, the processed curve is calculated
as the median of the data points within a window centered on the source
data point.

1

• The width of the window is determined by the parameter value, expressed
as number of data points.

When the source point is less than half the window size from the beginning
of the end of the curve, the median is calculated symmetrically round the
source point over as many data points as possible.

2

• If you increase the window width, the smoothing effect is also increased.

• To completely remove a noise spike, the window width should in effect
be slightly more than twice the width of the spike.
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The filter algorithmonly accepts odd integer parameter values between 1 and
151. If an even number has been given, it is incremented by adding the number
one (1).

Note:

Savitzky-Golay
The table below describes the process when the Savitzky-Golay smoothing algorithm
is used.

DescriptionStage

The algorithm is based on performing a least squares linear regression fit
of a polynominal of degree k over at least k+1 data points around each point
in the curve to smooth the data.

1

The derivative is the derivative of the fitted polynominal at each point.

The calculation uses a convolution formalism to calculate 1st through 9th
derivatives.

The calculation is performed with the data in low X to high X order.2

If the input trace goes from low to high, it is reversed for the calculation and
is re-reversed afterwards.

See Gorry, Peter A, General Least-Squares Smoothing and Differentation by
the Convolution (Savitsky-Golay) Method (Analytical Chemistry 1990, Volume
62, 570-573) for information about the Savitzky-Golay algorithm.

Tip:
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A.2 Baseline calculation theory

Introduction
There are two methods to calculate the baseline, based on a morphological and classic
algorithm.

Overall process
The table below describes the overall process of a baseline calculation.

DescriptionStage

The baseline segments are defined.1

The baseline points are selected.2

The baseline is drawn.3

Baseline segment definition
Baseline parameters are used to find the baseline segments. The default values for the
parameters are determined from the source curve. The baseline segments are found by
different parameters that are based on the type of algorithm that is selected.

The parameters can be displayed in the EvaluationClassicmodule if you choose
Integrate:Calculate baseline function. You can also click theBaseline settings
button in the Integrate:Peak integrate dialog.

Tip:

Morphological algorithm
The Morphological algorithm searches for all parts of the source curve where:

• The curve parts come into contact at both ends of a horizontal line of the length
defined in the Structure width parameter. The default value of this parameter is
based on the widest detected peak in the curve. The horizontal line is moved along
the curve up the peak until it reaches the contact points. The curve parts below the
horizontal line and the line will now form a "curve" with a plateau. The center point
in the plateau formed by the horizontal line will be the data point for the baseline.

• The data points fulfil the Minimum distance between data points. This parameter
reduces the total number of data points that are created from a curve.
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Classic algorithm
The Classic algorithm searches for all parts of the source curve where:

• The curve parts are longer than the Shortest baseline segment. This parameter
determines the minimum length for a part of the source curve to be considered a
possible baseline segment.

• The curve has no point outside the Noise window. The noise window is defined as
a rectangular corridor parallel to the slope of the curve and centered on the first and
last points within the currently inspected segment.

• The slope is less than the Slope limit. This limits the maximum slope of the baseline
to differentiate baseline segments from peaks.

• The curve parts are lower than the Max baseline level. This parameter determines
the highest acceptable signal level for the baseline.

The baseline parameters can be illustrated as a rectangular box that the source curve
has to fit into in order to be identified as a baseline segment, where:

• The length of the box corresponds to the Shortest baseline segment.

• The height of the box corresponds to the maximum level of noise on the baseline
segments. This is referred to as the Noise window.

• The box is allowed to be tilted with a maximum slope corresponding to the Slope
limit.

• The box is not allowed to move up above the Max baseline level.
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Baseline parameters -
illustration (Classic algorithm)

The illustrations below show the baseline parameters graphically.

Shortest baseline segment

Noise window

Max baseline level

Slope limit
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Baseline segment identification
(Classic algorithm)

The table below describes the baseline segment identification process:

DescriptionStage

The box is virtually moved along the source curve in steps of one third of
the Shortest baseline segment length to look for baseline segments.

1

A baseline segment is found whenever the currently examined part of the
source curve fits completely within the box.

2

The found baseline segments are joined by connecting adjacent segments,
provided that the slope of the joining lines does not exceed the Slope limit.

3

Baseline points (Classic
algorithm)

When the baseline segments have been defined and joined, they are replaced by baseline
points at the start and end of each segment. The line between these is also filled with
points.

The baseline points are shown as gray squares in the Integrate:Edit baseline
function of the Evaluation Classic module.

Tip:

Baseline drawing (Classic
algorithm)

The baseline points are used to create the baseline curve using a spline interpolation.
The spline function ensures that the baseline curve is guided by the baseline points.
However, the curve does not necessarily pass through the baseline points. The baseline
will be a smoothly curved function passing close to or through the points.

To reduce the effect of noise at the peak integration, the created baseline is forced equal
to the source curve in every position where the difference between the baseline and the
source curve is small enough. Choose Integrate:Calculate Baseline. If theAccept nega-
tive peaks option is off, the baseline will be forced down to the level of the source curve
whenever the created baseline goes above the source curve.
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Measure a Classic algorithm
baseline segment

You can try to measure the Shortest baseline segment length directly on your chro-
matogram. To measure the shortest baseline segment:

ActionStep

Locate the shortest segment of the curve that you consider a part of the
baseline.

1

Right-click in the chromatogram and choose Vertical marker.2

Use the Vertical marker to measure the length of the segment by reading
the start and end point values.

3

Choose Integrate:Calculate Baseline and insert this value as the Shortest
baseline segment value.

4

Measure noise level (Classic
algorithm)

Curve coordinates can also be used to measure noise levels on the source curve. To
measure noise levels:

ActionStep

Use the Zoom function to focus on a part of the curve that is representative
for the baseline noise.

1

Select an appropriate Y-axis scale.2

Measure the Y-axis coordinates.3

• Calculate the noise range as the difference between the max. and min.
values.

• Add an extra 20%.

• Choose Integrate:Calculate Baseline and insert this value as the Noise
window value.

4
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Measure the slope limit (Classic
algorithm)

Follow the instructions below to measure the slope at any part of the curve.

DescriptionStage

Select Operations:Differentiate in the Evaluation Classic module.1

Result: The Differentiate dialog opens.

• Select the desired source curve.

• Select the First order calculation option.

• Click OK.

Result: The differentiated curve will appear in the active chromatogram.

2

Select an appropriate Y-axis scale, right-click and select Vertical marker to
measure the Y-axis values for the differentiated curve with the curve coor-
dinates function.

3

Result: The Y-axis value is interpreted as the UV curve slope at the selected
retention point.

• Determine the highest slope value of the baseline (non-peak) part of the
curve.

• Add 10%.

• Select Integrate:Calculate Baseline and use this value as the Slope
limit.

4

If the differentiated curve is very noisy, it can be filtered with a lightMoving
average filter in the Operations:Smooth function.

Tip:
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A.3 Peak table column components

Introduction
This section contains a list of peak parameters with explanations and calculation formulae
when applicable.

Peak parameters - illustration
The diagram below illustrates the peak parameters. See the parameter list below for
explanations.

Peak parameter descriptions
The list below contains descriptions of the peak parameters.

DescriptionParameter

Calculated as the area between the curve and baseline, be-
tween the peak start and peak end, time or volume base (gray
area in the diagram above).

Area
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DescriptionParameter

Peak asymmetry (indicator of column packing). See definition
below this table.

Asymmetry

Baseline amplitude at peak start, peak maximum and peak
end (A, F and G in the diagram above).

Baseline height

The retention factor will only be calculated when the chro-
matogram is in volume base. The total liquid volume, Vt, must
be entered in the Peak Integrate dialog for this parameter to
be calculated. See definition below this table.

Retention factor

Fraction number at peak start, peak maximum and peak end.Fraction tube id

Maximum amplitude above the baseline (C-F in the diagram
above).

Height

Gel phase distribution constant in gel filtration. Kav will only
be calculated when a gel filtration column was used and when
the chromatogram is in volume base. The void volume, V0,
must be entered in thePeak Integratedialog for this parameter
to be calculated. See definition below this table.

Kav

Height equivalent to theoretical plate and plates/meter. The
column height must be entered in the Peak Integrate dialog
for this parameter to be calculated. See definition below this
table.

Plate height (HETP)

Amplitude above the baseline at left (A in the diagram above)
and right peak limits (E-G in the diagram above).

Peak endpoint
heights

Retention value at peak start and peak end, time or volume
base (A and G in the diagram above).

Peak endpoint re-
tention

Name of the peak.Peak name

Peak area as a percent of the total area under the curve above
the baseline. Time or volume base.

Note:

This value can differ in time and volume base if the flow rate is
not constant throughout the method.

Percent of total
area

Peak area as a percent of the sum of all integrated peaks.

Note:

This value can differ in time and volume base if the flow rate is
not constant throughout the method.

Percent of total
peak area
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DescriptionParameter

Peak resolution. See definition below this table.Resolution

Retention at the peak maximum, time or volume base (C in the
diagram above).

Retention

Standard deviation for a Gaussian-shaped peak. See definition
below this table.

Sigma

Identifies the criteria for peak start and peak end as either the
baseline intersection or dropline to the baseline or skim line.

Type of peak limits

Difference in retention between the peak end and peak start,
time or volume base (G-A in the diagram above).

Width

Calculated by taking the maximum height of the peak above
the baseline, then determining the peak width at half this value
above the baseline. Time or volume base. (B-D in the diagram
above, where BD bisects CF)

Width at half
height

In the Options dialog (which is available in all UNICORN modules from the
Toolsmenu) you can select if negative retentions should be displayed or not.
The default selection is that negative retention is displayed.

Note:

Asymmetry formula
The formula below is used to calculate the Asymmetry.

Asymmetry = B / A

Where:

• A is a partial peak width, measured at a percentage of the peak height (asymmetry
ratio), for the leading part of the peak.

• B is a partial peak width, measured at a percentage of the peak height (asymmetry
ratio), for the tailing part of the peak.
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Change the Asymmetry Ratio
The Asymmetry Ratio is selected in the Options dialog. The table below describes how
to select a value:

ActionStep

• Choose the Tools:Options menu item.

Result: The Options dialog opens.

1

• Type a ratio value in the Asymmetry Ratio at text box.

• Click OK.

Result: The ratio value is changed and the dialog closes.

2

You must repeat the peak integrations after the change to update the values
based on the new asymmetry ratio. The default ratio is 10%.

Note:

Retention factor formula
The formula below is used to calculate the Retention factor.

Where:

• VR = retention volume.

• Vt = total liquid volume.
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Kav formula
The formula below is used to calculate Kav.

Where:

• VR = retention volume.

• V0 = void volume.

• VC = column volume.

HETP formula
The formula below is used to calculate the HETP value.

HETP = L/N

N = 5.54 x (VR/wh)2 assuming a Gaussian peak.

Where:

• N = no. of theoretical plates.

• L = bed height in cm.

• VR = peak retention volume or time.

• wh = peak width at half height expressed in the same units as VR.

Peak resolution algorithms
The peak resolution is calculated with one of the following three algorithms:

1 (VR2 - VR1) / ((Wb2 + Wb1) / 2)

2 (VR2 - VR1) / ((Sigma2 + Sigma1) x 2)

3 ((VR2 - VR1) / (2 x (Wh2 + Wh1))) / 2.354

Where:

• VR1, Wb1, Sigma1 and Wh1 are the retention, width, Sigma and width at half height
of the previous peak.

• VR2, Wb2, Sigma2 and Wh2 are the retention, width, Sigma and width at half height
of the current peak.
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The Resolution Algorithm variable in the Options dialog determines which
of the three algorithms is used. The default setting is algorithm 3.

Note:

Change the peak resolution
algorithm

Follow the instructions to change the peak resolution algorithm in the Options dialog.

ActionStep

In the Administration module, on the Tools menu, click Options.1

Result: The Options dialog opens.

Click the Evaluation tab.2

In the Resolution Algorithm list, click the desired algorithm as described in
Peak resolution algorithms, on page 262.

3
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ActionStep

Click OK.

Result: The dialog closes and the peak resolution algorithm is changed.

You must repeat the peak integrations after the change to update the values
based on the new algorithm.

Note:

Sigma formula
The formula below is used to calculate Sigma.

Where:

• n is the number of data points.

• x is the volume or time value.

• xymax is the volume or time value at the maximum amplitude value.

• Apeak is the area of the peak.

Note: The peak width for a Gaussian peak is (4 x Sigma).
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A.4 Evaluation procedure instructions

Introduction
This section contains information about the procedure instructions that are available
for selection in the Instruction field of the Procedure Editor in the Evaluation Classic
module. Choose Procedures:Edit:New in the Evaluation Classic module to view the In-
struction list. The procedure instructions are used to build a complete, automated
evaluation procedure, which may be included in a method and executed as part of a
method run.

Tip: • The mouse pointer is placed over a parameter field to show the allowed
value range.

• The curve source is defined as the curve position number.

Curve operation
The table below contains a list of instructions for curve operations.

DescriptionInstruction

Adds two curves to produce a third curve, which is the sum of the
two curves. The two source curves must have the same Y-axis unit
and not be fraction, injection or run log curves, or else a run time
error will occur.

ADD

Multiplies the amplitude of the source curve by the multiplication
factor and stores the result in the target curve position.

AMP_MUL

Shifts the amplitude of the source curve by the shift factor and
stores the result in the target curve position.

AMP_SHIFT

Clears the specified curve from the working memory of the comput-
er.

CLEAR

Copies the source curve to the target curve position.COPY

Cuts out the part of the source curve between the Left and Right
limits and stores the result in the target curve position.

CUT

Differentiates the source curve (first or second order) and stores
the result in the target curve position. The Y-axis of the target curve
position will be a normalized scale without unit.

DERIVATE
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DescriptionInstruction

Divides two curves to produce a third curve, which is the quotient
of the two curves. The two source curves can have any Y-axis unit.
The Y-axis of the target curve position will be a normalized scale
without unit.

DIV

Creates a histogram from any non-fraction curve (source curve 1)
and a fraction curve (source curve 2_frac), and stores the result in
the target curve position. If source curve 2 is not a fraction curve a
run time error will occur. The Y-axis of the target curve position will
be the same as that of the first source curve.

HISTOGRAM

Performs a mathematical integration of the source curve and stores
the result in a Result curve. This instruction is not the same as Peak
integrate, which performs a real peak integration.

INTEGRATE

Multiplies the retention of the source curve by the Multiplication
factor and stores the result in the target curve position.

RET_MUL

Shifts the retention of the source curve by the Shift factor and stores
the result in the target curve position.

RET_SHIFT

Smooths the source curve with an autoregressive filter and stores
the result in the target curve position. The Filter parameter decides
the strength of the filter.

SMOOTH_AR

Smooths the source curve with a moving average filter and stores
the result in theResultingCurve. The Filterwidthparameter decides
how many samples wide the filter is.

SMOOTH_MA

Smooths the source curve with a median filter and stores the result
in target curve position. The Filter width parameter decides how
many samples wide the filter is.

SMOOTH_ME-
DIAN

Smooths the curve with the Savitzky-Golay algorithm.SMOOTH_SG

Subtracts two curves to produce a third curve, which is the differ-
ence of the two curves. The two source curves must have the same
Y-axis unit and not be fraction or injection curves.

SUB

Divides two curves to produce a third curve, which is the quotient
of the two curves. The two source curves can have any Y-axis unit.
The threshold values are used to avoid division of numbers close
to zero. At those points where source curve 1 has an amplitude less
than Threshold1, or the source curve 2 has an amplitude less than
Threshold2, the result of the division is defined to be 1.0.

TDIV
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Integration
The table below contains a list of instructions for integration.

DescriptionInstruction

Calculates a baseline from the source curve. The baseline is
stored in the target curve position.DEFAULT can be selected
in theBaselineparameters, which will then calculate default
baseline parameters for each new curve.

CALCULATE_BASE-
LINE

Calculates a baseline from the curve crvSrc using a morpho-
logical method. DEFAULT can be selected in the Baseline
parameters, which will then calculate default baseline param-
eters for each new curve. The baseline is stored in curve
crvDst.

CALCULATE_BASE-
LINE_MORPH

Clears the peak table inPeak table source from the computer
memory.

CLEAR_PEAKTABLE

Copies a peak table from Peak table source to Resulting
peak table.

COPY_PEAKTABLE

Controls the baseline behavior in subsequent baseline calcu-
lations. IfONOFF isON then the baseline can be drawn above
the curve and negative peaks can be detected by PEAK_IN-
TEGRATE. If ONOFF is OFF then the baseline is never drawn
above the curve.

NEGATIVE_PEAKS

Performs a peak integration on the source curve and stores
the resulting peak table inResultingpeak table. It is assumed
that the baseline is subtracted.

PEAK_INTEGRATE

Specifies which part of the source curve that will be integrat-
ed. Peaks between retention Left limit and Right limit will be
detected if the ONOFF parameter is set to ON. If ONOFF is
set to OFF, the whole curve will be used for integration.

PEAK_WINDOW

Any combination of conditions is allowed. If all parameters
are OFF then every detected peak is included in the peak
table.

REJECT_PEAKS

Sets the column height for the peak integration calculation
of the HETP value. The Column height parameter is the
height of the column in centimetres. If Column height isOFF
then the HETP value is not calculated for the following inte-
grations.

SET_COL-
UMN_HEIGHT

Sets void volume for Kav peak integration calculation.SET_COLUMN_V0
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DescriptionInstruction

Sets the total liquid volume for peak integration calculation
of the capacity factor.

SET_COLUMN_VT

Sets the Skim size ratio to be used in the following peak in-
tegration(s).

SET_SKIM_SIZE_RA-
TIO

Integrates the curve within the peak window. All curve parts
outside the peak window remain unchanged.

WINDOW_PEAK_IN-
TEGRATE

File operation
The table below contains a list of instructions for file operations.

DescriptionInstruction

Opens the curve specified in theResult file defined in File name
and stores it in target curve position. If "*" is entered as File
name the current result file will be used. The File name param-
eter may include a path from the users root folder.

CURVE_OPEN

Imports a curve to the current chromatogram from another
chromatogram (in the current file) and stores it in the target
curve position.

IMPORT_CURVE

Imports a peak table to the current chromatogram from another
chromatogram (in the current file) and stores it in the target
curve position.

IMPORT_PEAK-
TABLE

Opens the specified Peak table in the Result file defined in File
name and stores it in the Resulting peak table. If "*" is entered
as File name the current Result file will be used. The File name
parameter may include a path from the current users root
folder.

PEAK-
TABLE_OPEN
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Export
The table below contains a list of instructions for export operations.

DescriptionInstruction

Exports the curve entered in Curve source to the file de-
fined in Export to file in ASCII. If "*" is entered as file name
in the Export to file field the current Result file will be
used. If "?" is entered followed by text (e.g., "Enter a file
name"), as file name, a full search path must be entered
in answer to the question. In the part of the source curve
limited by the Left limit and Right limit every <n> sample
is exported.

EXPORT_CURVE_ASCII

Exports the documentation in the current result file in
ASCII format to the file defined in Export to file. If "*" is
entered as file name in the Export to file field the current
Result file will be used. If "?" is entered followed by text
(e.g., "Enter a file name"), as file name, a full search path
must be entered in answer to the question. If all parame-
ters to this function are OFF then no documentation is
exported. If at least one of them isON then the documen-
tation will be exported and the corresponding parts will
be included in the exported file.

EX-
PORT_DOC_400_ASCII

Exports the documentation in the current result file in MS
Excel XLS format to the file defined in Export to file. If "*"
is entered as file name in the Export to file field the cur-
rent Result file will be used. If "?" is entered followed by
text (e.g., "Enter a file name"), as file name, a full search
path must be entered in answer to the question. If all
parameters to this function areOFF then no documenta-
tion is exported. If at least one of them is ON then the
documentation will be exported and the corresponding
parts will be included in the exported file.

EXPORT_DOC_400_XLS

Exports an evaluation log in ASCII format to the file de-
fined in Export to file. If "*" is entered as file name in the
Export to file field the current Result file will be used. If
"?" is entered followed by text (e.g., "Enter a file name"),
as file name,, a full search path must be entered in answer
to the question.

EX-
PORT_EVAL_LOG_ASCII
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DescriptionInstruction

Exports an evaluation log in Excel .xls format to the file
defined in Export to file. If "*" is entered as file name in
the Export to file field the current Result file will be used.
If "?" is entered followed by text (e.g., "Enter a file name"),
as file name, a full search path must be entered in answer
to the question.

EXPORT_EVAL_LOG_XLS

Exports a method to the file defined in Export to file in
ASCII format. If "*" is entered as file name in the Export
to file field the currentResult file will be used. If all param-
eters are OFF then no method is exported. If Main is ON
then the main method is included and ifBlocks isON then
all blocks are included in the exported file.

EXPORT_METHOD_ASCII

Exports a method to the file defined in Export to file in
Excel .xls format. If "*" is entered as file name in the Export
to file field the current Result file will be used. If "?" is en-
tered followed by text (e.g., "Enter a file name"), as file
name, a full search path must be entered in answer to
the question. If all parameters are OFF then no method
is exported. IfMain isON then the main method is includ-
ed and if Blocks is ON then all blocks are included in the
exported file.

EXPORT_METHOD_XLS

Exports multiple curves (previously defined with EX-
PORT_SEL_CURVES instructions) in ASCII format to the
file defined in Export to file. If "*" is entered as file name
in the Export to file field the current Result file will be
used. If "?" is entered followed by text (e.g., "Enter a file
name"), as file name, a full search path must be entered
in answer to the question.

EXPORT_MUL-
TI_CURVES_ASCII

Exports multiple curves (previously defined with EX-
PORT_SEL_ CURVES instructions) in comma separated
value .csv format to the file defined in Export to file. If "*"
is entered as file name in the Export to file field the cur-
rent Result file will be used. If "?" is entered followed by
text (e.g., "Enter a file name"), as file name, a full search
path must be entered in answer to the question.

EXPORT_MUL-
TI_CURVES_CSV

Normalizes retention when exporting multiple curves.EXPORT_NOR-
MALISE_RETENTION
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DescriptionInstruction

Exports the peak table in Peak table source to the file
defined in Export to file in ASCII format. If "*" is entered
as file name in the Export to file field the current Result
file will be used. If "?" is entered followed by text (e.g.,
"Enter a file name"), as file name, a full search path must
be entered in answer to the question.

EXPORT_PEAK-
TABLE_ASCII

Exports the peak table in Peak table source to the file
defined in Export to file in Excel .xls format. If "*" is entered
as file name in the Export to file field the current Result
file will be used. If "?" is entered followed by text (e.g.,
"Enter a file name"), as file name, a full search path must
be entered in answer to the question.

EXPORT_PEAK-
TABLE_XLS

Exports the peak table in Peak table source to the file
defined in Export to file in XML format. If "*" is entered as
file name in the Export to file field the current Result file
will be used. If "?" is entered followed by text (e.g., "Enter
a file name"), as file name, a full search path must be en-
tered in answer to the question.

EXPORT_PEAK-
TABLE_XML

Selects a curve for subsequent export (using the EX-
PORT_MULTI-CURVES_* instruction). The curve is cut
according to the right and left cut limit and the number
of points to be exported may be set by the Export param-
eter (for example, every fifth point).

EXPORT_SEL_CURVES

Chromatogram functions
The table below contains a list of instructions for chromatogram functions.

DescriptionInstruction

Resets the destination for the subsequent curve and peak
table operations to the default chromatogram. Used to-
gether with the SET_DESTINATION_CHROM instruction.

RESTORE_DESTINA-
TION_ CHROM

Opens the named chromatogram as destination for the
subsequent curve and peak operations. Used together
with the RESTORE_ DESTINATION_CHROM instruction.

SET_DESTINA-
TION_CHROM
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Other instructions
The table below contains a list of instructions for other operations.

DescriptionInstruction

Sets the X-axis base that the following calculations will be made
in. If the value of the X-axis base is DEFAULT, then the default
base is used (usually the base the method was run in). This instruc-
tion should be the first in the evaluation procedure, otherwise it
will have no effect.

BASE

Inserts a comment below the marked instruction.Comment

Marks the end of a LOOP statement.ENDLOOP

The instructions between this statement and the ENDLOOP
statement are repeated n times. It is possible to have loops within
loops as long as the number of LOOP statements matches the
number of ENDLOOP statements.

LOOP

Performs a QC test according to the parameter settings.QC_TEST

Prints a report with the specified named report layout and title. If
Title is "*" then the title in the report layout is used. If Report
Layout is "*" then a default layout is used.

REPORT

Starts a program as a separate process. TheProgramname string
contains the program name and parameters to start it with.

RUN_PROGRAM

Test instructions
The Instruction field also contains a group of test instructions. These instructions are
only available for the UNICORN software development team.

DescriptionInstruction

Sets the area intervals for theAUTOSAMPLER_PEAK_TEST.AUTOSAM-
PLER_PEAK_INTERVALS

Locates the first peak in the peak table. Compares the
area of the peak in the peak table with the specified
maximum and minimum areas.

AUTOSAM-
PLER_PEAK_TEST

Finishes the current result and saves the output file as an
ASCII file in a destination and with a file name specified
in the variable DestFilename (.txt). A complete search path
may be included in the file name.

EXPORT_TEST_RE-
SULT_TO_FILE
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DescriptionInstruction

Sets the level intervals for the NEW_GRADIENT_TEST.GRADIENT_TEST_INTER-
VALS

The theoretical straight line between the 0% and 100%
levels are calculated. The deviation between the curve
and the ideal straight line is compared in both directions
from the center position (50%) until the deviation exceeds
the defined maximum deviation. The calculated deviation
points are checked against the defined limits.

NEW_GRADIENT_TEST

The relative amplitude is calculated at the specified reten-
tions (the 0% and 100% amplitudes are used for refer-
ence). The calculated relative amplitudes are checked
against the specified error margins. The 0% level ampli-
tude is verified to be within the specified interval from the
absolute 0 level.

NEW_STEP_RE-
SPONSE_TEST

Verifies that the curve amplitude has changed more than
or equal to the value of the Delta parameter between the
defined to and from retention points. A print parameter
may be set to On to generate printed results.

NEW_TEST_CURVE_AM-
PLITUDE_CHANGE

Verifies that the curve amplitude is stable between the
defined to and from retention points. The actual curve
value is compared to a set amplitude parameter. If the
difference exceeds a set Delta value, the test is failed. A
print parameter may be set to On to generate printed re-
sults.

NEW_TEST_CURVE_AM-
PLITUDE_STABLE

Verifies if a specified text is present in the logbook curve
between the defined to and from retention points. The
test can be defined to be passed either if the text is
present or not. A failed or passed text will be added to the
output file. A print parameter may be set to On to gener-
ate printed results.

NEW_TEST_LOG-
BOOK_EVENT

The amplitudes for the 0% and 100% levels are calculated
and the difference between the values are calculated.
The results of (1) Curve2_Difference / Curve1_Difference
and (2) Curve2_Difference / Curve3_Difference are calcu-
lated. The calculated points are checked if they are outside
the defined limits from the 50% level.

NEW_UV_RE-
SPONSE_TEST

Sets the level intervals for the NEW_STEP_RE-
SPONSE_TEST.

STEP_RESPONSE_INTER-
VALS
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DescriptionInstruction

Adds selected information items to the output file (e.g.,
system name), UNICORN version, etc. Also, a specified
free text can be added. A print parameter may be set to
On to generate printed results.

TEST_INFO

Sets the level intervals for theNEW_UV_RESPONSE_TEST.UV_RESPONSE_INTER-
VALS

274 UNICORN 7.0 Evaluation Manual 29-1108-88 AA

A Evaluation functions and instructions
A.4 Evaluation procedure instructions



Index
A
Auto Hide
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B
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Adjust the baseline graphi-
cally, 116
Calculate a new, 118
Definition of a segment, 252
How to edit manually, 133
Parameters, 253
Reuse existing, 104
The Calculate function, 103

Blank curve
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C
Chromatograms
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one, 220
Apply a saved layout, 58
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is, 53
Change and fix the Y-ax-
is, 51
Change curve color and
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Choose curve name appear-
ance, 46
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from result files, 169
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Default curve names, 46
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Fraction text alignment, 48

How to copy curves into a
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compare, 162
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ments, 27
Measure using marker refer-
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Subtract curves, 221
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compare, 165
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How to set, 140
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ments, 256
Measure noise level, 256
Measure the slope limit, 257
Missing peaks, 146
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Parameters, 140
Shortest baseline seg-
ment, 142
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When to change the Max
baseline level, 147

Curves
Add curves, 220
Apply a saved layout, 58
Change and fix the X-ax-
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Change and fix the Y-ax-
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Change curve color and
style, 47
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ance, 46
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Default curve names, 46
Differentiate a curve, 224
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How to export, 207
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Run log text display, 48
Save layouts, 57
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Subtract curves, 221

D
Data migration
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E
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How to sign a result, 193
Evaluation Classic module

Design of Experiment result,
illustration, 22
File Navigator, 19
How to exit, 196
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matogram layout changes,
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Evaluation procedures
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matograms, 239
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File Navigator

How to close, 39
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Files
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tion, 154
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lation, 153
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Show only the pooled frac-
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P
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Select part of a curve for
peak integration, 124

Peaks
Add a fill color and pat-
tern, 119
Add peak names, 122
Adjust the start and end
points manually, 115
Change the peak resolution
algorithm, 263
Delete peaks, 123
Display peak labels, 110
Drop-lines, description, 115
Edit integration for part of a
curve, 125
How to filter from view, 109
Include negative peaks in
integration, 129
Join peaks, 121
Labels, 110
Open the peak table for
editing, 112
Peak identification through
the absorbance ratio, 158
Peak purity, 158
Peak skim compared to
separating with
droplines, 129
Select a peak skim ratio, 130
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Split a peak, 121
Peak skim

Compared to droplines, 129
Select a ratio, 130

Peak table
How to export, 209
How to rename, 192
Select contents, 217

Procedure instructions
Curve operations, 265

Procedures
Add instructions by record-
ing, 236
Delete procedures, 242
Edit a procedure, 235
Global procedures, 234
How to build a procedure
with instructions, 234
Record an evaluation proce-
dure, 232
Rename procedures, 242
Run a single procedure, 238
Runs on multiple chro-
matograms, 239

Protein activity
Match to UV curve, 157

Protein amount in fractions
Calculate in Fraction His-
togram dialog, 154

Protein concentration
Calculate in Fraction His-
togram dialog, 153

R
Recent runs

Listed in the Result Naviga-
tor, 34

Reports
Add a peak table, 87
Add chromatograms, 87
Add documentation, 90
Add objects to a report, 84
Add pages, 82
Add picture objects, 86
Alignment toolbar icons in
Customize Report, 92
Change the page setup, 83
Create a new report for-
mat, 79

Customize Report - general
toolbar icon functions, 81
Customize Report toolbar
command buttons, 80
Delete pages, 82
Edit an existing report for-
mat, 95
Generate and print a prede-
fined format, 76
How to add free text, 85
Include Method objects, 89
Include the Evaluation
log, 91
Save a new report for-
mat, 94
Save a report in PDF for-
mat, 77

Result files
Electronic signature, 193
Export options, 204
How to export for use in an-
other UNICORN
database, 205
How to rename, 192
How to save, 195
Import, 201
Open a result, 24

Result Navigator
Expand or collapse fold-
ers, 32
Preference settings, 35
Recent Runs list, 34
Toolbar icons, 30
Use Find Results to locate a
file, 36
Use the advanced search
function to locate a file, 38

Run documentation
Documentation tabs, de-
scription, 64
Evaluation log, 71
How to export, 210
Print, 63
Result information, 68
Run log, 71
Save the used method as a
new method, 73
Search for log entry text, 72
System information, 70
View, 63
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S
Slope values

Measure values, 224
Usage, 223

Smooth function
Use smooth function to re-
move noise or ghost
peaks, 218

Smoothing algorithms
Autoregressive, 249
Median, 250
Moving average, 249
Savitzky-Golay, 251

Snapshots
Record a snapshot of curve
values, 217
Take a Snapshot of curve
values in a result, 29

T
Troubleshooting

column performance
test, 245
distorted peaks, 245
evaluation procedures, 244
export of archived re-
sult, 247
import UNICORN 5 re-
sult, 246
maximum number of curves
exceeded, 244

Typographical conventions, 11

U
UNICORN workflow, 8

Z
Zero baseline

Definition, 104
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